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About This Guide

This Administration guide consists of comprehensive, conceptual information to help you 
understand and use Novell® ZENworks® 6.5 Handheld Management. 

The sections include:

Chapter 1, “Setting Up Handheld Import,” on page 11

Chapter 2, “Using ZENworks Handheld Management Policies,” on page 17

Chapter 3, “Using Queries and Groups,” on page 67

Chapter 4, “Distributing Software to Handheld Devices,” on page 81

Chapter 5, “Using Inventory and Reports,” on page 93

Chapter 6, “Making System Configuration Changes,” on page 109

Appendix A, “Troubleshooting,” on page 125

Appendix B, “Configuring SSL and HTTP Settings,” on page 131

Additional Documentation

For information about installing ZENworks Handheld Management, see the Novell ZENworks 6.5 
Handheld Management Installation Guide.

For the most updated version of this Administration guide, see Novell Documentation Web site 
(http://www.novell.com/documentation/zenworks65).

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

User Comments

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.
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1 Setting Up Handheld Import

Novell® ZENworks® 6.5 Handheld Management provides simplified, hands-off management of 
enterprise handheld devices.

For more information about installing ZENworks Handheld Management, see the Novell 
ZENworks 6.5 Handheld Management Installation Guide.

In order to manage the handheld devices, you must do the following: 

Import handheld devices into Novell eDirectoryTM.

The following sections provide information you need for setting up an Import policy:

“Creating the Handheld Service Package” on page 11

“Configuring the Handheld Import Policy” on page 13

“Associating the Handheld Service Package” on page 16

Ensure that the users synchronize their handheld devices using their normal synchronization 
process (Microsoft* ActiveSync, Palm* HotSync, and so forth).

After the handheld objects are imported into the directory, you can begin using policy-based 
management, distributing software applications to individual handheld devices or to groups 
of handheld devices, collecting hardware and software inventory for all enterprise handheld 
devices, and more.

Set up the policies that can be associated with handheld objects. For more information, see 
Chapter 2, “Using ZENworks Handheld Management Policies,” on page 17.

Creating the Handheld Service Package
A policy package is an eDirectory object containing one or more individual policies. A policy 
package groups policies according to function, making it easier to administer them. It also provides 
the means for the administrator to change policy settings and to determine how they affect other 
eDirectory objects.

In ZENworks Handheld Management, the Handheld Service Package contains one policy: 
Handheld Import.

You should create an Organizational Unit (OU) to hold the policy packages. Consider the 
following when determining where to place this OU:

Partitions in your tree

The 256-character limit in eDirectory for the full distinguished name

The Search policy that is used to locate the policy package
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To minimize tree walking, it is best to create this policy package OU at the root of the partition 
that contains the objects with which the policy package will be associated. It also maximizes the 
number of characters that will be available for naming the policy.

To create the Handheld Service Package:

1 In Novell ConsoleOne®, right-click the container where you want the container for the policy 
packages placed, click New, then click Organizational Unit.

2 Give the container a short name, then click OK.

3 Right-click the newly created container that will hold your policy packages, click New, then 
click Policy Package.

4 Select Handheld Service Package, then click Next.

5 Give the policy package a short name, then click Next.

6 Review the information in the Summary page, then click Finish.
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Configuring the Handheld Import Policy
1 In ConsoleOne, right-click the Handheld Service Package object that is created during 

“Creating the Handheld Service Package” on page 11, then click Properties.

2 Select the check box under the Enabled column for the Handheld Import policy.

This both selects and enables the policy.

3 Click Properties.

The Location tab of the General page is displayed. 

You can configure the Handheld Import policy on this page to enable importing of 
BlackBerry*, Palm OS*, and Windows* CE devices.
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In addition to the General page, ZENworks Handheld Management provides three platform-
specific pages: BlackBerry, Palm, and Windows CE. If you want to specify different settings 
for each type of device, you can use the appropriate platform page. For example, you could 
specify different containers to hold the different types of handheld devices.

4 Click the down-arrow on the Platforms tab, then select the desired platform.

5 Fill in the fields:

Enable Platform Settings to Override General Settings: This option displays only on the 
BlackBerry, Palm, and WinCE platform pages. Select this option if you want the settings 
specified on the BlackBerry, Palm, or WinCE page to override those settings specified on the 
General page.

Allow Importing of Handhelds: Enable this option to allow registered handheld devices to 
be imported into the directory.

Create Handheld Objects In: Select an option from the drop-down list.

Selected Container: The handheld device objects are created in the container specified 
in the Path field. This is an absolute DS path.

Server Container: The handheld device objects are created in the same container where 
the handheld service object is created. You can specify a relative DS path from the server 
container.

Associated Object Container: The handheld device objects are created in the container 
that is associated with the Handheld Import policy. You can specify a relative DS path 
from the associated container.

Relative Path = handheld. means to go up one level from the container to create the handheld 
device object.

Path: If you are using a relative path, enter a string. The number of periods you end the path 
with determines the number of relative levels. If you are using an absolute path, select the 
container.
NOTE: The Description box describes where the handheld device objects are created, based on the 
settings you selected on the Location page. Review the description and make any necessary changes.

6 Click the Naming tab.
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7 Fill in the fields:

Handheld Name: Displays the handheld naming convention currently defined in the Add 
Name Fields and Place Them in Order list.

Whenever there is a potential name conflict (such as two handheld device objects in the same 
container with the same name), the system appends a number on the end of the name that you 
enter here.

Add Name Field and Place Them in Order: You must have at least one option in this list.

You can add or remove options, or click the arrows to move an option up or down the list. The 
handheld device objects are named in the order these options display in the list.

The name options are:

<User Defined>: You can any text here such as the separator between the Device and 
User value. For example, Device_UserName. In this example, the underscore ( _ ) is the 
user defined value.

Device: The device’s name.

User: The device's owner name or the name provided by Palm HotSync or Microsoft 
ActiveSync. 

Computer: The name of the Access Point to which the device is connected.

8 Click the Groups tab.

9 Click Add, then browse for the Handheld Group objects you want this handheld device object 
to belong to when it is imported.

For more information about Handheld Group objects, see “Using Groups” on page 70.

10 Click OK to save the policy.

11 Continue with “Associating the Handheld Service Package” on page 16.
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Associating the Handheld Service Package
The Handheld Import policy you configured and enabled is not in effect until you associate its 
policy package with the ZENworks Handheld Management Service object directly or with a 
container object.

To associate the Handheld Service Package:

1 In ConsoleOne, right-click the Handheld Service Package, then click Properties.

2 Click the Associations tab, then click Add.

3 To associate the package, browse for the ZENworks Handheld Management Service object, 
the container containing the Service object, or the container object created during the 
installation of ZENworks Handheld Management server components.

4 Click OK.
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2 Using ZENworks Handheld Management 
Policies

For Novell® ZENworks® 6.5 Handheld Management to function properly, you must create the 
policy packages so that you can configure, enable, and associate your planned policies.

A policy package is a Novell eDirectoryTM object containing one or more individual policies. A 
policy package groups policies according to function, making it easier to administer them. It also 
provides the means for the administrator to change policy settings and to determine how they affect 
other eDirectory objects.

ZENworks Handheld Management has four policy packages: Container Package, Handheld 
Package, Handheld Service Package, and Handheld User Package. 

The following sections contain additional information:

“Understanding ZENworks Handheld Management Policies” on page 17

“Creating Policy Packages” on page 20

“Setting Up Container Package Policies” on page 21

“Setting Up Handheld Package and Handheld User Policies” on page 28

“Setting Up Handheld Service Package Policies” on page 63

“Viewing Policy Status Information” on page 63

Understanding ZENworks Handheld Management Policies
The following table lists each ZENworks Handheld Management policy, indicates the package 
that contains the policy, and provides a brief description of the policy.

Policy Container Description

Handheld Import Policy Handheld Service Package Lets you enable handheld import and configure 
settings, such as how handheld device objects are 
named, where they are stored in eDirectory, and 
which Handheld Group objects you want certain 
handheld device objects associated with.

For more information, see Chapter 1, “Setting Up 
Handheld Import,” on page 11.

Search Policy Container Package Lets you specify how far up the tree ZENworks 
Handheld Management searches for effective 
policies.

For more information, see “Search Policy” on 
page 23.
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Handheld Application 
Search Policy

Container Package Lets you specify how far up the tree ZENworks 
Handheld Management searches for Handheld 
Application objects.

For more information, see “Handheld Application 
Search Policy” on page 25.

BlackBerry Configuration 
Policy

Handheld Package and Handheld User 
Package

Lets you set configuration information for associated 
BlackBerry* devices, including the owner name for 
the device and any additional information you want 
to include.

For more information, see “BlackBerry 
Configuration Policy” on page 28.

BlackBerry Inventory Policy Handheld Package and Handheld User 
Package

Lets you enable the collection of hardware and 
software inventory from associated BlackBerry 
devices.

For more information, see “BlackBerry Inventory 
Policy” on page 30.

BlackBerry Security Policy Handheld Package and Handheld User 
Package

Lets you ensure that a password is set on 
associated BlackBerry devices.

For more information, see “BlackBerry Security 
Policy” on page 32.

Palm Client Configuration 
Policy

Handheld Package Lets you enable user authentication on associated 
Palm OS* devices.

For more information, see “Palm Client 
Configuration Policy” on page 34.

Palm Configuration Policy Handheld Package and Handheld User 
Package

Lets you set general preferences, such as auto-off, 
system sound, and beam retrieve settings; 
associate different software programs with the 
buttons on the Palm OS device; assign a feature 
users can access when they drag the pen from the 
writing area to the top of the screen on the Palm OS 
device; and specify which software programs are 
allowed or not allowed on Palm OS devices. 

For more information, see “Palm Configuration 
Policy” on page 36.

Palm File Retrieval Policy Handheld Package and Handheld User 
Package

Lets you specify files to retrieve from the associated 
Palm OS device to copy to a specified location.

For more information, see “Palm File Retrieval 
Policy” on page 39.

Policy Container Description
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Palm Security Policy Handheld Package and Handheld User 
Package

Lets you ensure that a password is set on the 
associated Palm OS device and lets you configure 
Auto Lock Configuration and enhanced password 
protection. 

Also lets you specify self-destruct settings to disable 
a Palm device after a specified number of failed 
password attempts or after a specified number of 
days since the device was last synchronized.

For more information, see “Palm Security Policy” on 
page 43.

WinCE Client Configuration 
Policy

Handheld Package Lets you enable user authentication on associated 
Windows* CE devices.

For more information, see “WinCE Client 
Configuration Policy” on page 47.

WinCE Configuration Policy Handheld Package and Handheld User 
Package

Lets you associate different software programs or 
functions with the buttons on the associated 
Windows CE device; specify which programs you 
want to include on the Start menu (on a Pocket PC) 
or on the desktop (on a handheld PC); and specify 
power settings for Windows CE devices.

For more information, see “WinCE Configuration 
Policy” on page 48.

WinCE File Retrieval Policy Handheld Package and Handheld User 
Package

Lets you specify files to retrieve from the associated 
Windows CE device to copy to a specified location.

For more information, see “WinCE File Retrieval 
Policy” on page 52.

WinCE Security Policy Handheld Package and Handheld User 
Package

Lets you ensure that a password is set on the 
Windows CE device and configure enhanced 
security options for Pocket PCs.

Also lets you specify self-destruct settings to disable 
a Windows CE device after a specified number of 
failed password attempts or after a specified 
number of days since the device was last 
synchronized.

For more information, see “WinCE Security Policy” 
on page 57.

Policy Container Description
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Creating Policy Packages
A policy package is an eDirectory object containing one or more individual policies. Before you 
can configure, enable, and associate the policies contained in a policy package, you must create 
the policy package.

1 In Novell ConsoleOne®, right-click the container that will hold your policy packages, the 
click New > Policy Package.

2 Select Container Package.

or

Select Handheld Package.

or

Select Handheld Service Package.

or

Select Handheld User Package.
TIP: To list the policies that are contained in each policy package, click the name of each policy in the 
Policy Packages list on the left side of the Policy Package Wizard page. The available policies will display 
in the Policies list on the right side of the Policy Package Wizard page.

3 Click Next.

4 Give the policy package a short name, then click Next.

5 Review the information in the Summary page, then click Finish.
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Setting Up Container Package Policies
In ZENworks Handheld Management, the Container package contains two policies: Search and 
Handheld Application Search.

The following sections contain additional information:

“Search Policy Overview” on page 21

“Search Policy” on page 23

“Handheld Application Search Policy” on page 25

“Associating the Container Package” on page 27

Search Policy Overview
ZENworks Handheld Management policies are associated to a handheld device object in any of 
the following ways:

To the handheld device object itself

To a User object

To a Handheld Group where the handheld device is a member

To a User Group where the user is a member

To a parent container of the handheld device or User object

The search order that ZENworks Handheld Management uses is consistent with standard 
eDirectory behavior and any search policies that are in the tree. By default, ZENworks Handheld 
Management starts at the handheld device or user object, followed by any Handheld groups or 
User groups that the device is a member of, and then starts walking up the tree looking for policies 
to enforce. All handheld policies are merged and the culmination is applied to the handheld device. 
If any conflicts occur, such as two Palm Configuration policies (one associated directly to the 
handheld device object and the other associated to a parent container of the handheld device 
object), the first policy found is enforced. In this case, the Palm Configuration policy directly 
associated to the handheld device object is enforced.

If a policy contained in a Handheld User Package and another policy in the Handheld Package 
conflict, the settings in the Handheld User Package are enforced. For example, if you configure 
and enable the Palm Configuration policy in the Handheld User Package, but you also have an 
enabled Palm Configuration policy in the Handheld Package, the policy is the Handheld User 
Package takes precedence.

The File Retrieval policies (Palm File Retrieval and WinCE File Retrieval) present exceptions to 
rule that the first policy found is enforced. These policies are both plural (meaning they can be 
added many times to a policy package) and cumulative (meaning that many different File Retrieval 
policies with different settings can be effective for a single handheld device object, handheld group 
object, or container object). Because the File Retrieval policies are plural and cumulative, no 
conflicts occur when ZENworks Handheld Management encounters multiple File Retrieval 
policies: every effective File Retrieval policy is enforced.

The Search policy is used to limit how far up the tree ZENworks Handheld Management searches 
for the effective policies. In addition to limiting how far up the tree ZENworks Handheld 
Management searches for policies, both policies let you determine the searching order (object, 
group, container) that ZENworks Handheld Management uses as it searches for policies. The 
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search order is significant because the first policy found is enforced (except for the File Retrieval 
policies, as explained previously). 

The Handheld Application Search policy is used to limit how far up the tree ZENworks Handheld 
Management searches for handheld application objects.

If your directory contains many objects, ZENworks Handheld Management performs significant 
tree-walking if no search policies are enabled. For this reason, you should make use of both the 
Search policy and the Handheld Application Search policy.

The Search policy and the Handheld Application Search policy provide the following benefits

Improved security

The ability to reorder a search

Better search performance by limiting the search levels traversed in eDirectory and by 
avoiding unnecessary LAN traffic

The Search policy specifies how ZENworks Handheld Management determines which policies are 
associated with handheld device objects. The Handheld Application Search policy specifies how 
ZENworks Handheld Management determines which handheld application objects are associated 
with handheld device objects. To make either search policy effective, you associate it with a 
container. Both search policies apply to handheld device or user objects within or beneath a given 
container.

You can specify the number of levels above or below the location to begin the search:

Without a search policy in effect, the default is to search from the parent container to [Root]. The 
search checks each container up the tree towards [Root] for policy packages and handheld 
application objects associated with those containers.

The default search policy recognizes the policy package associated with the handheld device 
object before it looks in any group or container where such an object resides.

The default search order, Object > Group > Container, can be reordered and can include as few as 
one of the locations. For instance, you can exclude Group objects by setting the search order to 
Object > Container.

You can avoid unnecessary LAN traffic by searching to an associated container instead of [Root].

The Search policy is required for finding other policies. You set up Search policies at a container 
level. Set up as many Search policies as you need to help minimize network traffic.

Number Description

0 Limits the search to the selected level.

1 Limits the search to one level above the selected level.

For example, if you selected the handheld device object’s parent container, this would 
limit the search to one level above the parent level.

-1 Limits the search to one level below the selected level.

For example, if you selected [Root], -1 would limit the search to one level below 
[Root].
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Search Policy
The Search policy is used to limit how far up the tree ZENworks Handheld Management searches 
for the effective policies.

To set up a Search policy:

1 In ConsoleOne, right-click the newly created Container Package, then click Properties.

For information on creating the Container Package, see “Creating Policy Packages” on 
page 20.

2 Select the check box under the Enabled column for the Search policy.

This both selects and enables the policy.

3 Click Properties to display the Search Level page.
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4 Select the level to search to from the drop-down list:

[Root]: Search from the handheld device object to the root of the tree.

Object Container: Search from the handheld device object to the parent container of the 
object.

Associated Container: If you are using ZENworks for Handhelds 4 or later, Partition has 
been replaced with Associated Container. If you select Associated Container, ZENworks 
Handheld Management searches to the partition boundary.

Selected Container: Search from the handheld device object to the selected container.

5 If you chose Selected Container, browse to select the container.

6 To determine the searching limits in either direction, specify a number between -25 and 25.

7 Click the Search Order tab.
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8 Specify the policy searching order, using the arrow keys, the Add button, and the Remove 
button as necessary.
NOTE: Depending on which other ZENworks products (ZENworks Desktop Management and ZENworks 
Server Management) are present, ConsoleOne might display a Refresh Interval page; however, 
ZENworks Handheld Management does not use the settings on the Refresh Interval page.

9 Click OK.

10 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Container Package” on page 27 to associate the policy package.

Handheld Application Search Policy
The Handheld Application Search policy is used to limit how far up the tree ZENworks Handheld 
Management searches for Handheld Application objects.

To set up the Handheld Application Search policy:

1 In ConsoleOne, right-click the Container Package, then click Properties.
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2 Select the check box under the Enabled column for the Handheld Application Search policy.

This both selects and enables the policy.

3 Click Properties to display the Search Level page.

4 Select the level to search to:

[Root]: Search from the handheld device object to the root of the tree.

Object Container: Search from the handheld device object to the parent container of the 
object.
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Associated Container: If you are using ZENworks for Handhelds 4 or later, Partition has 
been replaced with Associated Container. If you select Associated Container, ZENworks 
Handheld Management searches to the partition boundary.

Selected Container: Search from the handheld device object to the selected container.

5 If you chose Selected Container, browse to select the container.

6 To determine the searching limits in either direction, specify a number between -25 and 25.

7 Click the Search Order tab.

8 Specify the policy searching order.

Use the arrow keys, the Add button, and the Remove button as necessary to create your search 
order.

9 Click OK.

10 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Container Package” on page 27 to associate the policy package.

Associating the Container Package
The policies you configured and enabled are not in effect until you associate their policy package 
with a container object.

1 In ConsoleOne, right-click the Container Package, then click Properties.

2 Click the Associations tab > Add.

3 Browse for the container for associating the package, then click OK.
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Setting Up Handheld Package and Handheld User Policies
ZENworks Handheld Management provides Handheld Package and Handheld User Package 
policies for the Palm OS, Windows CE, and BlackBerry platforms.

Each platform has its own page where you can view and configure available policies. To display 
a desired platform page: In ConsoleOne, right-click the Handheld Package or the Handheld User 
Package, click Properties, click the down-arrow on the Policies tab, then click the appropriate 
platform: Palm, WinCE, or BlackBerry.

Review the following sections for more information to help you set up the Handheld Package and 
Handheld User Package policies:

“BlackBerry Configuration Policy” on page 28

“BlackBerry Inventory Policy” on page 30

“BlackBerry Security Policy” on page 32

“Palm Client Configuration Policy” on page 34

“Palm Configuration Policy” on page 36

“Palm File Retrieval Policy” on page 39

“Palm Security Policy” on page 43

“WinCE Client Configuration Policy” on page 47

“WinCE Configuration Policy” on page 48

“WinCE File Retrieval Policy” on page 52

“WinCE Security Policy” on page 57

“Associating the Handheld Package or the Handheld User Package” on page 61

“Scheduling Packages and Policies” on page 61

BlackBerry Configuration Policy
The BlackBerry Configuration policy lets you specify a standard owner name and additional 
information that is set on the associated BlackBerry devices. For example, you could specify that 
your company name, address, and telephone number be set on all associated BlackBerry devices 
to help recover lost devices.

The owner name and information that you specify using this policy does not affect the naming of 
the device objects in eDirectory; the owner name and information you specify in this policy 
displays only on the actual device.

To set up the BlackBerry Configuration policy:

1 In ConsoleOne, right-click the Handheld Package or Handheld User Package object, then 
click Properties.
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2 On the Policies tab, click the down-arrow, then click BlackBerry.

3 Select the check box under the Enabled column for the BlackBerry Configuration policy.

This both selects and enables the policy.

4 Click Properties to display the Owner page.

5 Fill in the fields:

Owner Name: Select the Specify Owner Name To Be Set on the Handheld check box, then 
type the owner name that you want to be set on associated BlackBerry devices.
Using ZENworks Handheld Management Policies 29



    Novell Confidential                                                                                            Manual (ENU)  21 December 2004
Owner Information: Select the Specify Owner Information To Be Set on the Handheld 
check box, then type any additional information that you want to be set on associated 
BlackBerry devices.

The owner name and information that you specify using this policy does not affect the naming 
of the device objects in Novell eDirectory; the owner name and information you specify in 
this policy displays only on the actual device.

6 Click OK to save the policy.

7 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

8 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.
NOTE: For BlackBerry devices, a policy schedule of Custom Event:EventHandheldSync gets translated 
on the device to Daily.

BlackBerry Inventory Policy
The BlackBerry Inventory policy lets you enable the collection of hardware and software 
inventory from associated BlackBerry devices.

To set up the BlackBerry Inventory policy:

1 In ConsoleOne, right-click the Handheld Package or the Handheld User Package object, then 
click Properties.

2 On the Policies tab, click the down-arrow, then click BlackBerry.

3 Select the check box under the Enabled column for the BlackBerry Inventory policy.

This both selects and enables the policy.
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4 Click Properties to display the General page.

5 Fill in the fields:

Hardware: To collect hardware information for associated BlackBerry devices, select the 
Enable Collection of Hardware Inventory on the Handheld check box.

Collected data about hardware is stored on a per-device basis and is found on the ZENworks 
Inventory page in ConsoleOne or on the Clients: Hardware Inventory page in the ZENworks 
Handheld Management Inventory Viewer. To view the ZENworks Inventory page in 
ConsoleOne, right-click a handheld device object, click Properties, then click the ZENworks 
Inventory tab. To open the ZENworks Handheld Management Inventory Viewer, right-click 
a handheld device object, click Actions, then click Inventory. For more information, see 
“Viewing Hardware Inventory” on page 104.

Software: To collect software information for associated BlackBerry devices, select the 
Enable Collection of Software Inventory on the Handheld check box.

Collected data about software is found in the ZENworks Handheld Management Inventory 
Viewer. To open the ZENworks Handheld Management Inventory Viewer, right-click a 
handheld device object, click Actions, then click Inventory. You can view software inventory 
information for a specific device or across all BlackBerry devices in your system. For more 
information, see “Viewing Software Inventory” on page 94.

6 Click OK to save the policy.

7 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

8 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.
NOTE: You must schedule inventory for BlackBerry devices because they are always connected to the 
ZENworks Handheld Management Server. For Palm and Windows CE devices, you do not need to 
schedule inventory; software inventory is collected once a day.

For BlackBerry devices, a policy schedule of Custom Event:EventHandheldSync gets translated on the 
device to Daily.
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BlackBerry Security Policy
The BlackBerry Security policy lets you ensure that a password is set on associated BlackBerry 
devices. You can also use the BlackBerry Device Lockout feature to lock a device that you suspect 
has been lost or stolen. For more information, see “BlackBerry Device Lockout” on page 33.

To set up the BlackBerry Security policy:

1 In ConsoleOne, right-click the Handheld Package or Handheld User Package object, then 
click Properties.

2 On the Policies tab, click the down-arrow, then click BlackBerry.

3 Select the check box under the Enabled column for the BlackBerry Security policy.

This both selects and enables the policy.

4 Click Properties to display the Security page.
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5 Select the Require a Password To Be Set On the Handheld check box.

If your organization has a rule stating that all handheld devices must have a password, you 
should enable this policy. 

When the BlackBerry Security policy is enforced, if the user does not have a password set, he 
or she is prompted to create one. If the user ignores the prompt, he or she is prompted every 
15 minutes to create a password for the device.

6 Click OK to save the policy.

7 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

8 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.
NOTE: For BlackBerry devices, a policy schedule of Custom Event:EventHandheldSync gets translated 
on the device to Daily.

BlackBerry Device Lockout

The BlackBerry Device Lockout feature lets you disable a BlackBerry device if you suspect that 
it has been lost or stolen. After the device is locked, no applications can run on the device other 
than ZENworks Handheld Management, which can be used to unlock the device.

To lock or unlock a BlackBerry device:

1 In ConsoleOne, right-click the desired BlackBerry handheld device object, click Actions, then 
click Lock/Unlock Device.

2 Click Unlock the Device.

or

Click Lock the Device, then type the text you want displayed on the device when in is locked.

3 Click OK.
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Palm Client Configuration Policy
The Palm Client Configuration policy lets you override the user authentication settings of the 
ZENworks Handheld Management Service object for associated Palm OS devices.

You can set up user authentication on a global basis for all handheld devices in your ZENworks 
Handheld Management system during installation or you can edit the properties of the ZENworks 
Handheld Management Service object.

If you do not want to enable user authentication for all handheld devices in your system, you can 
choose to not enable global user authentication during installation or by editing the properties of 
the ZENworks Handheld Management Service object. You can then configure and enable the Palm 
Client Configuration policy by following the procedure in this section to target only specific 
handheld devices or groups of handheld devices.

For more information about setting up user authentication on a global basis during installation, see 
“Installing the ZENworks Handheld Management Server” in the Novell ZENworks 6.5 Handheld 
Management Installation Guide. For more information about editing the properties of the 
ZENworks Handheld Management Service object to enable global user authentication, see 
“Configuring User Authentication” on page 109.

If user authentication is enabled, the user is prompted for his or her credentials (username and 
password) the first time the device connects/synchronizes. ZENworks Handheld Management will 
then authenticate the user using LDAP to log in to the directory. After the user is authenticated, 
you can target policies and applications to the user of the handheld device. 

The user must enter the credentials only once; ZENworks Handheld Management does not prompt 
the user for the credentials again. If a user that has been authenticated gives the device to another 
person, you should reconfigure the user on the device itself. For more information, see the 
documentation that came with your handheld device.

If the device uses the Palm IP client to connect, the user-authentication dialog box displays on the 
handheld device. If the device uses Palm HotSync, the user-authentication dialog box displays on 
the desktop computer during synchronization.

When the user is prompted for authentication, if he or she clicks Cancel, the handheld device can 
be managed by device policies, but user-based management does not function because the user is 
not authenticated. If the user mis-types the username or password, he or she is immediately 
prompted for the credentials again.
NOTE: There are two places in ZENworks Handheld Management where users can be required to enter a 
password: to authenticate to the directory as part of the Palm Client Configuration policy and to power on a 
handheld device as part of the Palm Security policy. These two passwords are independent of each other. For 
more information about the password users must enter to power on a device, see “Palm Security Policy” on 
page 43.

To set up the Palm Client Configuration policy:

1 In ConsoleOne, right-click the Handheld Package object, then click Properties.
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2 On the Policies tab, click the down-arrow, then click Palm.

3 Select the check box under the Enabled column for the Palm Client Configuration policy.

This both selects and enables the policy.

4 Click Properties to display the User Authentication page.

5 Select the Override the Server Configuration check box to override the user authentication 
settings of the ZENworks Handheld Management Service object.

6 Select the Enable User Authentication on Handhelds check box.
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7 Click OK to save the policy.

8 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

Palm Configuration Policy
The Palm Configuration policy lets you configure the following:

General Preferences: Lets you set preferences for associated Palm OS devices, for example 
how long before an idle device turns itself off, whether or not a device stays on when cradled, 
and more.

Buttons: Lets you associate different software programs with the buttons on associated Palm 
OS devices. Also lets you assign a feature users can access when they drag the pen from the 
writing area to the top of the screen on the Palm OS device. For example, you can select Turn 
Off & Lock to make it easier for users to turn off and lock their Palm OS devices.

Programs: Lets you specify which software programs are allowed or not allowed on 
associated Palm OS devices. Programs that are not allowed can be automatically removed 
from the devices.

To set up the Palm Configuration policy:

1 In ConsoleOne, right-click the Handheld Package or Handheld User Package object, then 
click Properties.

2 On the Policies tab, click the down-arrow, then click Palm.

3 Select the check box under the Enabled column for the Palm Configuration policy.

This both selects and enables the policy.

4 Click Properties.
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5 On the General page, make the desired configuration changes.

You can change the settings for the following preferences:

Auto-Off After

Stay On in Cradle

System Sound

Alarm Sound

Alarm Vibrate

Alarm LED

Game Sound

Beam Receive

Each preference in the list contains a Don't Change setting. If you choose this setting, 
ZENworks Handheld Management does not change that preference on associated devices; the 
corresponding setting on each device determines its behavior. For example, if you choose the 
Don't Change setting for Auto-Off After, each associated device uses its own preference 
settings to determine how long an idle Palm OS device waits until it turns itself off. If you 
want to ensure consistency across all associated Palm OS devices, choose the appropriate 
setting.

6 On the Buttons: Configuration page, make the desired configuration changes.
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The Button Column lists the available buttons on the Palm OS device. To change a button's 
association, select a button from the Button list, click Edit, click Set to Application, browse 
to an application, then click OK. 
NOTE: Depending on your particular Palm OS device, the available buttons in the Button list are named 
differently than those in the preceding illustration.

The Pen Function drop-down list lets you assign a feature users can access when they drag the 
pen from the writing area to the top of the screen on the Palm OS device. For example, you 
can select Turn Off & Lock to make it easier for users to turn off and lock their Palm OS 
devices. To assign a feature, choose an option from the drop-down list.

The following options are available:

Not Specified

Backlight

Keyboard

Graffiti Help

Turn Off & Lock

Beam Data

7 On the Programs page, make the desired configuration changes.
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The Application column lists the applications that you want to allow on the device or remove 
from the device. To add an application to the list, click Add, browse to the application, then 
click OK.

Select a rule to apply to the application:

Allow the Application on the Handheld

Remove the Application from the Handheld

Rather than selecting certain applications to be removed from the device, you might find it 
easier to specify a list of allowed applications and select the Remove All Other Applications 
from the Handheld check box. When the policy is enforced or when the user synchronizes the 
device, all applications not listed in the Applications list with the Allow rule set are removed 
from the device.

8 Click OK to save the policy.

9 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

10 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.

Palm File Retrieval Policy
The Palm File Retrieval policy lets you specify source files you want to retrieve from a Palm OS 
device and copy to a specified destination location.

The File Retrieval policy is a plural policy, meaning it can be added many times to a policy 
package. You can set up as many File Retrieval policies as required to adequately retrieve 
important files from the handheld devices in your organization. When you name these plural 
policies, be sure to give them descriptive names.
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The File Retrieval policy is also cumulative, meaning that many different Palm File Retrieval 
policies can be effective for a single handheld device object, handheld group object, or container 
object.
NOTE: If you want to retrieve files from handheld devices and store them on a Novell NetWare® volume, you 
must install the Novell ClientTM on the ZENworks Handheld Management Server.

To set up the Palm File Retrieval policy:

1 In ConsoleOne, right-click the Handheld Package object or the Handheld User Package 
object, then click Properties.

2 On the Policies tab, click the down-arrow, then click Palm.

3 Click Add.

4 Type a descriptive name in the Policy Name field, then click OK.

The newly created File Retrieval policy displays in the Handheld Policies list.
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5 Select the check box under the Enabled column for the newly created Palm File Retrieval 
policy.

This both selects and enables the policy.

6 Click Properties to display the Files page.

7 In the Files field, specify the source files to be retrieved from the handheld device.
NOTE: You must specify the Palm database or resource filename in the Files field. A third-party file utility 
tool (such as FileZ, a shareware program) might be necessary to determine the actual filename.
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When you specify source files, be aware that filenames are case sensitive. You can use 
wildcard characters to specify source files.

When the policy is enforced, all specified source files are retrieved from the device; the files 
are retrieved even if the same files were previously retrieved at another time.

8 Select the Files Are Required check box if you want ZENworks Handheld Management to 
report a failed status if the specified files do not exist on the handheld device or if the specified 
wildcard characters do not provide a match for files on the device.

For more information about policy status, see “Viewing Policy Status Information” on 
page 63.

9 Select the Delete Files After Retrieval check box if you want the specified source files to be 
deleted from the handheld device after they have been retrieved from the handheld device.

If you do not enable this option, the source files are copied to the specified location but will 
also remain on the handheld device. 

10 In the Path field, browse to or specify the destination location where you want the specified 
files copied to.

The renamed file can include variables. To include variables, click the Insert button, then click 
the desired variable.

The following variables are available for use:

To use a variable, place an @ sign on either side of the variable in the string. For example, 
you could use the following syntax:

@user@_filename

Variable Description

device The CN of the device. For example, in Dan m130.Handhelds.NovellWheaton, 
the string would be Dan m130.

devicedn The full DN of the device. For example, In Dan 
m130.Handhelds.NovellWheaton, the string would be Dan 
m130.Handhelds.NovellWheaton.

user The username of the device. This is the value stored in the    UserName 
attribute for the object in the directory. When this value is not configured on 
the handheld device, it is set to <Undefined>.

date The date the file was retrieved from the handheld device. This value is the 
date only; the time that the file was retrieved is not included. For example, if 
the file was retrieved on September 15, 2002 at 3:15 p.m., the string would 
be 2002-09-15. The string is always in the format of yyyy-mm-dd.

time The time the file was retrieved from the handheld device. This value is for the 
time only; the date that the file was retrieved is not included. For example, if 
a file was retrieved on September 15, 2002 at 3:20 p.m., the string would be 
15-20. The string is always in the format of hh-mm, with hh representing the 
hour in 24-hour format.

guid The GUID for the handheld device.

server The name of the server that received the data. This is the Windows NT* name 
of the server.
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11 Select Use the Original File Name(s) to use the original source filenames for the destination 
files.

or

Select Rename the Files To and specify new filenames for the destination files. 

12 Click OK to save the policy.

13 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

14 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.

Palm Security Policy
The Palm Security policy lets you configure the following:

Password Requirements: Lets you ensure that a password is set on the associated Palm 
devices and also lets you configure enhanced security options, such as the number of days to 
allow before a password expires, the number of grace logons permitted before the user must 
change the password, the minimum number of characters to allow for the password, and 
whether the password must contain a mix of letters and numbers. For devices running Palm 
OS 4.x or newer, you can also configure auto-lock options.
NOTE: There are two places in ZENworks Handheld Management where users can be required to enter 
a password: to authenticate to the directory as part of the Palm Client Configuration policy and to power 
on a handheld device as part of the Palm Security policy. These two passwords are independent of each 
other. For more information about the password users must enter to authenticate to the directory, see 
“Palm Client Configuration Policy” on page 34.

Self-Destruct Settings: Lets you specify self-destruct settings to disable a Palm device after 
a specified number of failed password attempts or after a specified number of days since the 
device was last connected or synchronized. 

To set up the Palm Security policy:

1 In ConsoleOne, right-click the Handheld Package or Handheld User Package object, then 
click Properties.
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2 On the Policies tab, click the down-arrow, then click Palm.

3 Select the check box under the Enabled column for the Palm Security policy.

This both selects and enables the policy.

4 Click Properties to display the Security page.

5 Fill in the fields:

Require a Password to Be Set on the Handheld: Lets you specify that a password must be 
set on the Palm OS device. If your organization has a rule that states that all handheld devices 
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must have a password, you should enable this policy. If a user does not have a policy set, he 
or she is prompted to create one.

For Palm OS devices, ZENworks Handheld Management replaces the Palm password applet 
if you select Require a Password to Be Set on the Handheld; users will see ZENworks 
Handheld Management password dialog boxes rather than the default Palm OS dialog boxes.

Enable Enhanced Password Support: Select this option to specify enhanced password 
support. 

Minimum Password Length: Select this check box and specify the minimum number of 
characters to allow for the password on the device. You should choose a number great enough 
to ensure adequate security, but small enough not to excessively burden the user.

Require Alphanumeric Mix: Select this check box to require that the user use both letters 
and numbers in the password. To improve the security of a password, it should contain both 
letters (uppercase and lowercase) and numbers.

Password Expires In _ Days: Select this check box and specify the number of days that you 
want the password to expire in. When the specified number of days has expired, the user is 
prompted to change the password for the device.

Limit Grace Logons to _ Attempts: Select this check box and specify the number of grace 
logon attempts you want to allow the user before he or she must change the password for the 
device. After the number of days in Password Expires in _ Days, the user is prompted to 
change the password. The user can choose to ignore this prompt and keep the same password 
for the number of logon attempts you specify.

Require Unique Passwords: Select this check box to require that the user enter a new 
password; he or she cannot reuse the previous eight passwords.

Enable Auto Lock Configuration (Palm OS 4.x and Above): Lets you specify that the Palm 
OS device is automatically locked when the specified event occurs. Using this policy 
improves the security of the data on your Palm OS devices. To use this setting, the handheld 
device must be running Palm OS 4.x or later.

The available settings include:

Never

On Power Off

At Present Time

After a Preset Delay

6 Click the Self-Destruct tab.
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The Self-destruct page lets you configure self-destruct settings for Palm OS devices so that 
data is not accessible from handheld devices that are lost or stolen. When the self-destruct 
feature is activated, the data on the device is made unusable and the device must be manually 
reset, which restores the device to its out-of-the-box state.

To use the self-destruct options for Palm OS devices, you must select the Require a Password 
to Be Set on the Handheld check box on the Security page.
IMPORTANT: Use caution when you use the self-destruct feature. Be sure to allow an adequate number 
of password attempts and an adequate number of days since the last connection or synchronization to 
prevent data loss to users who incorrectly enter the password or do not connect or synchronize the device 
during a short vacation.

For Palm devices using HotSync, if the user synchronizes the device using the same desktop or laptop 
machine as usual, the data can be restored by HotSync. 

7 Fill in the fields:

Bad Password Attempts: Select the Enforce Self-destruct check box and specify the number 
of bad password attempts to allow before activating the self-destruct feature.

Time Since Last Connection: Select the Enforce Self-Destruct check box and specify the 
number of days after the last connection before activating the self-destruct feature. The Time 
Since Last Connection option refers to the last time the handheld device connected to the 
Access Point.

Each day is made up of 24 hours. If you connect (synchronize) the device on Monday at 2 p.m. 
and specify three days after the last connection before activating the self-destruct feature, the 
self-destruct feature activates Thursday at 2 p.m (72 hours after the last connection/
synchronization) unless the device is connected/synchronized during that period.

8 Click OK to save the policy.

9 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

10 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.
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WinCE Client Configuration Policy
The WinCE Client Configuration policy lets you override the user authentication settings of the 
ZENworks Handheld Management Service object for associated WinCE devices.

You can set up user authentication on a global basis for all handheld devices in your ZENworks 
Handheld Management system during installation or you can edit the properties of the ZENworks 
Handheld Management Service object.

If you do not want to enable user authentication for all handheld devices in your system, you can 
choose to not enable global user authentication during installation or by editing the properties of 
the ZENworks Handheld Management Service object. You can then configure and enable the 
WinCE Client Configuration policy by following the procedure in this section to target only 
specific handheld devices or groups of handheld devices.

For more information about setting up user authentication on a global basis during installation, see 
“Installing the ZENworks Handheld Management Server” in the Novell ZENworks 6.5 Handheld 
Management Installation Guide. For more information about editing the properties of the 
ZENworks Handheld Management Service object to enable global user authentication, see 
“Configuring User Authentication” on page 109.

If user authentication is enabled, the user is prompted for his or her credentials (username and 
password). ZENworks Handheld Management then authenticates the user using LDAP to log in to 
the directory. After the user is authenticated, you can target policies and applications to the user of 
the handheld device.

If the device uses the Windows IP client to connect, the user-authentication dialog box displays on 
the handheld device.

When the user is prompted for authentication, if he or she clicks Cancel, the handheld device can 
be managed by device, but user-based management does not function because the user is not 
authenticated. If the user mis-types the username or password, he or she is immediately prompted 
for the credentials again.
NOTE: There are two places in ZENworks Handheld Management where users can be required to enter a 
password: to authenticate to the directory as part of the WinCE Client Configuration policy and to power on a 
handheld device as part of the WinCE Security policy. These two passwords are independent of each other. 
For more information about the password users must enter to power on a device, see “WinCE Security Policy” 
on page 57.

To set up the WinCE Client Configuration policy:

1 In ConsoleOne, right-click the Handheld Package or Handheld User object, then click 
Properties.
Using ZENworks Handheld Management Policies 47



    Novell Confidential                                                                                            Manual (ENU)  21 December 2004
2 On the Policies tab, click the down-arrow, then click WinCE.

3 Select the check box under the Enabled column for the WinCE Client Configuration policy.

This both selects and enables the policy.

4 Click Properties to display the User Authentication page.

5 Select the Override the Server Configuration check box to override the user authentication 
settings of the ZENworks Handheld Management Service object.

6 Select the Enable User Authentication on Handhelds check box.

7 Click OK to save the policy.

8 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

WinCE Configuration Policy
The WinCE Configuration policy lets you configure the following:

Buttons: Lets you associate different software programs with the buttons on the Windows CE 
device. Also lets you assign another function to a button. For example, you can assign the Start 
Menu to a button on the Windows CE device, making it easier for users to access the Start 
menu.

Programs: Lets you specify which programs you want to include on the Start Menu (on a 
Pocket PC) or on the desktop (on a Handheld PC). Programs that are not allowed can be 
automatically removed from the Start menu/desktop of the device.

Power: Lets you specify power settings for associated Windows CE devices. You can specify 
power settings that apply to Windows CE devices running on internal batteries or on external 
power.

To set up the WinCE Configuration policy:
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1 In ConsoleOne, right-click the Handheld Package or Handheld User object, then click 
Properties.

2 On the Policies tab, click the down-arrow, then click WinCE.

3 Select the check box under the Enabled column for the WinCE Configuration policy.

This both selects and enables the policy.

4 Click Properties.
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5 On the Buttons: Configuration page, click Add to change a button’s assignment.

To view the button naming conventions for your particular handheld device: on the handheld 
device, click Start > Settings > Buttons. For example, on a Compaq* iPAQ Pocket PC, the 
buttons are named Button 1, Button 2, and so forth. On a HP* Jornada Pocket PC, the buttons 
are named Hot key 1, Hot key 2, and so forth.

6 Select a button or type the name of a button, click OK, then select an option: 

Reset to Default: Resets the selected button's association to the factory default 
association. 

Set to Application: Lets you specify the application to assign to the selected button. If 
you specify an application that is not in the Start menu path (or subpath), the button applet 
might not show the correct settings and you are prompted to restart the handheld device 
to see the changes.

Set to Other Function: Lets you specify a function from the drop-down list to assign a 
function to the selected button.

The available options include:

<Input Panel>

<None>

<Scroll Down>

<Scroll Left>

<Scroll Right>

<Scroll Up>

<Start Menu>

<Today>

7 On the Programs: Start Menu/Desktop page, make the desired configuration changes.
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Click Add to specify a program to be added to the Short Cut list, fill in the Shortcut Name box 
(this is the name that displays in the Start menu or on the desktop), fill in the Target path (the 
full path to an application’s executable file), then click OK.

Rather than selecting certain programs to be removed from the device's Start menu/desktop, 
you might find it easier to specify a list of allowed applications and select the Move All Other 
Start Menu/Desktop Items to the Programs Folder check box. When the policy is enforced, all 
programs not listed in the Icon Name list are moved to the Programs folder.

Click Hide All Items in the Programs Folder to hide the names and icons of all listed programs 
in the Programs folder. Using this option lets the user run applications only from the Start 
menu (on Pocket PC devices) or on the desktop (on handheld PC devices).

8 Click OK to save the policy.

9 On the Power page, make the desired configuration changes.
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NOTE: The Power settings do not apply to HP Jornada devices running MicrosoftPocket PC 2002 
software.

If you select the Don't Change setting, ZENworks Handheld Management does not change 
that setting on associated devices; the corresponding setting on each device determines its 
behavior. For example, if you select the Don't Change setting, each associated device uses its 
own preference settings to determine how long an idle Windows CE device waits until it turns 
itself off. If you want to ensure consistency across all associated Windows CE devices, select 
the appropriate setting.

If you select the Disable setting, ZENworks Handheld Management disables that setting on 
all associated Windows CE devices; idle Windows CE devices do not shut down.

10 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

11 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.

WinCE File Retrieval Policy
The WinCE File Retrieval policy lets you specify source files you want to retrieve from a 
Windows CE device and copy to a specified destination location.

The WinCE File Retrieval policy is a plural policy, meaning it can be added many times to a policy 
package. You can set up as many File Retrieval policies as required to adequately retrieve 
important files from the handheld devices in your organization. When you name these plural 
policies, be sure to give them descriptive names.

The WinCE File Retrieval policy is also cumulative, meaning that many different WinCE File 
Retrieval policies can be effective for a single handheld device object, handheld group object, or 
container object.
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NOTE: If you want to retrieve files from handheld devices and store them on a NetWare volume, you must 
install the Novell Client on the ZENworks Handheld Management Server.

To set up the WinCE File Retrieval policy:

1 In ConsoleOne, right-click the Handheld Package or Handheld User Package, then click 
Properties.

2 On the Policies tab, click the down-arrow, then click WinCE.

3 Click Add. 

4 Type a descriptive name in the Policy Name field, then click OK.

The newly created File Retrieval policy displays in the Handheld Policies list.
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5 Select the check box under the Enabled column for the newly created WinCE File Retrieval 
policy.

This both selects and enables the policy.

6 Click Properties to display the Files page.

7 In the Path field in the Source Files box, specify the path to the source files.

8 In the Files field, browse to or specify the source files to be retrieved from the Windows CE 
device.
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You can use wildcard characters to specify source files.

When the policy is enforced, all specified source files will be retrieved from the device; the 
files are retrieved even if the same files were previously retrieved at another time.

9 Select the Files Are Required check box if you want ZENworks Handheld Management to 
report a failed status if the specified files do not exist on the Windows CE device or if the 
specified wildcard characters do not provide a match for files on the device.
NOTE: For more information about policy status, see “Viewing Policy Status Information” on page 63.

10 Select the Delete Files After Retrieval check box if you want the specified source files to be 
deleted from the Windows CE device after they have been retrieved from the handheld device.

If you do not enable this option, the source files are copied to the specified location but also 
remain on the Windows CE device. 

11 In the Path field in the Destination Location box, browse to or specify the destination location 
where you want the specified files copied to.

The renamed file can include variables. To include variables, click the Insert button, then click 
the desired variable.

The following variables are available for use:

To use a variable, place an @ sign on either side of the variable in the string. For example, 
you could use the following syntax:

@user@_filename

Variable Description

device The CN of the device. For example, in Dan 
m130.Handhelds.NovellWheaton, the string would be Dan m130.

devicedn The full DN of the device. For example, In Dan 
m130.Handhelds.NovellWheaton, the string would be Dan 
m130.Handhelds.NovellWheaton.

user The username of the device. This is the value stored in the zfhUserName 
attribute for the object in the directory. When this value is not configured on 
the handheld device, it is set to <Undefined>.

date The date the file was retrieved from the handheld device. This value is the 
date only; the time that the file was retrieved is not included. For example, 
if the file was retrieved on September 15, 2002 at 3:15 p.m., the string would 
be 2002-09-15. The string is always in the format of yyyy-mm-dd.

time The time the file was retrieved from the handheld device. This value is for 
the time only; the date that the file was retrieved is not included. For 
example, if a file was retrieved on September 15, 2002 at 3:20 p.m., the 
string would be 15-20. The string is always in the format of hh-mm, with hh 
representing the hour in 24-hour format.

guid The GUID for the handheld device.

server The name of the server that received the data. This is the Windows NT 
name of the server.
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12 Select Use the Original File Name(s) to use the original source filenames for the destination 
files.

or

Select Rename the Files To and specify new filenames for the destination files. 

13 Click OK to save the policy.

14 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

15 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.

WinCE Security Policy
The WinCE Security policy lets you configure the following:

Password Requirements: Lets you ensure that a password is set on associated Windows CE 
devices and also lets you configure enhanced security options for Pocket PCs, such as the 
number of days to allow before a password expires, the number of grace logons permitted 
before the user must change the password, the minimum number of characters to allow for the 
password, and whether the password must contain a combination of letters and numbers.
NOTE: There are two places in ZENworks Handheld Management where users can be required to enter 
a password: to authenticate to the directory as part of the WinCE Client Configuration policy and to power 
on a handheld device as part of the WinCE Security policy. These two passwords are independent of 
each other. For more information about the password users must enter to authenticate to the directory, 
see “WinCE Client Configuration Policy” on page 47.

Self-Destruct Settings: Lets you specify self-destruct settings to disable a Windows CE 
device after a specified number of failed password attempts or after a specified number of 
days since the device was last connected or synchronized.

IMPORTANT: The WinCE Security policy does not function on Jornada Pocket PCs running Microsoft 
Windows for Pocket PC 2000 software. Jornada Pocket PCs must be running Microsoft Pocket PC 2002 
software to use the WinCE Security policy.

To set up the WinCE Security policy:

1 In ConsoleOne, right-click the Handheld Package object, then click Properties.
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2 On the Policies tab, click the down-arrow, then click WinCE.

3 Select the check box under the Enabled column for the WinCE Security policy.

This both selects and enables the policy.

4 Click Properties to display the Security page.

5 Fill in the fields:

Require a Password to Be Set on the Handheld: Lets you specify that a password must be 
set on the Windows CE device. If your organization has a rule that states that all handheld 
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devices must have a password, you should enable this policy. If a user does not have a 
password set, he or she is prompted to create one.

Pocket PC Options: Lets you specify enhanced security options for Pocket PCs. The options 
in this group box are disabled unless you check Require a Password to Be Set on the 
Handheld.

Enable Enhanced Password Support: Select this option to specify enhanced password 
support settings for Pocket PCs.

For Pocket PCs, where enhanced security like biometric is not supported by the device, 
if you select Enable Enhanced Password Support, ZENworks Handheld Management 
displays it’s own password dialog box instead of default Windows CE dialog box.
IMPORTANT: For Pocket PCs, where the device supports enhanced security, if you select Enable 
Enhanced Password Support, ZENworks Handheld Management displays a dialog box saying that 
a password must be set on the device. In that case, the default Windows CE dialog box will be 
shown.

The Enable Enhanced Password Support option does not function on handheld PCs.

If, in the future, you want to remove the ZENworks Handheld Management password 
applet and restore the original Windows CE password applet, you need to reconfigure the 
WinCE Security policy and disable the Enable Enhanced Password Support option and 
then resynchronize the device so that the policy is enforced. Uninstalling the ZENworks 
Handheld Management handheld client on the device or disassociating the device from 
the WinCE Security policy does not remove the ZENworks Handheld Management 
password applet replacement. 
NOTE: You can replace the bitmap image that displays in the ZENworks Handheld Management 
password dialog boxes with a bimap image of your choosing. For more information, see “Replacing 
the ZENworks Handheld Management Password Dialog Box Bitmap Image” on page 61.

Minimum Password Length: Select this check box and specify the minimum 
number of characters to allow for the password on the device. You should choose a 
number great enough to ensure adequate security, but small enough not to 
excessively burden the user.

Require Alphanumeric Mix: Select this check box to require that the user use both 
letters and numbers in the password. To improve the security of a password, it should 
contain both letters (uppercase and lowercase) and numbers.

Password Expires in _ Days: Select this check box and specify the number of days 
that you want the password to expire in. When the specified number of days has 
expired, the user is prompted to change the password for the Pocket PC.

Limit Grace Logons to _ Attempts: Select this check box and specify the number 
of grace logon attempts you want to allow the user before he or she must change the 
password for the device. After the number of days in Password Expires in _ Days, 
the user is prompted to change the password. The user can choose to ignore this 
prompt and keep the same password for the number of logon attempts you specify.

Require Unique Passwords: Select this check box to require that the user enter a 
new password; he or she cannot reuse the previous eight passwords.

Pocket PC 2002 Options: Lets you specify a time limit that the Pocket PC can be turned off 
for before a password prompt is displayed when the device is turned back on. For example, if 
you set this option to 5 minutes, if the user turns the device off and then back on within 5 
minutes, no password is required to use the device. However, if more than 5 minutes passes, 
the user must enter a password to use the device.
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Display Password Prompt for Unused Devices Within: Select this check box and 
choose a time limit from the drop-down list.

The Windows CE device user can change the corresponding setting on the actual 
handheld device; however, the value you enter in the Display Password Prompt for 
Unused Devices Within field in ZENworks Handheld Management is the maximum 
amount of time the user can set; he or she cannot increase the time limit beyond this value.

6 Click the Self-Destruct tab.

The Self-Destruct page lets you configure self-destruct settings for Windows CE devices so 
that data is not accessible from handheld devices that are lost or stolen. When the self-destruct 
feature is activated, the data on the device is made unusable and the device must be manually 
reset, which restores the device to its out-of-the-box state.

To use the self-destruct options for Windows CE devices, you must select the Enable 
Enhanced Password Support check box on the Security page. You cannot use the self-destruct 
options on handheld PCs because the Enable Enhanced Password Support option does not 
function on them.
IMPORTANT: Use caution when you use the self-destruct feature. Be sure to allow an adequate number 
of password attempts and an adequate number of days since the last connection or synchronization to 
prevent data loss to users who incorrectly enter the password or do not connect or synchronize the device 
during a short vacation.

For Windows CE devices, ActiveSync does not automatically back up data. If the user has manually 
backed up the data, he or she can then manually restore the data to the device.

7 Fill in the fields:

Bad Password Attempts: Select the Enforce Self-Destruct check box and specify the number 
of bad password attempts to allow before activating the self-destruct feature.

Time Since Last Connection: Select the Enforce Self-destruct check box and specify the 
number of days after the last connection before activating the self-destruct feature. The Time 
Since Last Connection option refers to the last time the handheld device connected to the 
Access Point.
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Each day is made up of 24 hours. If you connect (synchronize) the device on Monday at 2 p.m. 
and specify three days after the last connection before activating the self-destruct feature, the 
self-destruct feature activates Thursday at 2 p.m (72 hours after the last connection/
synchronization) unless the device is connected/synchronized during that period.

8 Click OK to save the policy.

9 When you have finished configuring all of the policies for this package, continue with the 
steps under “Associating the Handheld Package or the Handheld User Package” on page 61 
to associate the policy package.

10 If desired, schedule the policy. For more information, see “Scheduling Packages and Policies” 
on page 61.

Replacing the ZENworks Handheld Management Password Dialog Box Bitmap Image

You can replace the ZENworks Handheld Management bitmap image that displays in the 
following ZENworks Handheld Management password dialog boxes with a bimap image of your 
choosing:

The login dialog box if you selected Enable Enhanced Password Support in Step 5 on page 58.

The dialog boxes that display when the WinCE Security policy is enforced and you selected 
Require a Password to Be Set on the Handheld in Step 5 on page 58. 

To replace the bitmap image in these dialog boxes, create a bitmap file called logo.bmp and 
place it in the ZENworks Handheld Management installation directory on the handheld 
device. The size of this bitmap image should be 240 pixels wide by 35 pixels high. 

Associating the Handheld Package or the Handheld User Package
The policies you configured and enabled are not in effect until you associate their policy package 
with a handheld device object, a User object, a handheld group object, a user group, or a container 
object.

1 In ConsoleOne, right-click the Handheld Package or Handheld User Package object, then 
click Properties.

2 Click the Associations tab > Add.

3 Browse for the object for associating the package, then click OK. 

The Handhelds Package can be associated with a handheld device object, a handheld group 
object, or a container object containing these objects.

The Handhelds User Package can be associated with a User object, a user group object, or a 
container object containing these objects.

Scheduling Packages and Policies
Some policies can be scheduled to run at a certain time. During creation, all policy packages are 
given a default run schedule (EventHandheldSync, by default). This means that all applicable 
policies in this package are enforced every time the handheld device synchronizes/connects to the 
Access Point. However, you can change the entire policy package schedule, or you can set a policy 
within the package to run at a different time from the rest of the package.

If you should enable a policy but fail to schedule it, it runs according to the schedule currently 
defined in the Default Package Schedule.
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If you have configured and enabled policies, but they have not been enforced on individual 
handheld devices, consider the following:

1. When you configure and enable policies, ConsoleOne records the new information in the 
directory.

2. The ZENworks Handheld Management Server scans for new information hourly, by default. 
You must wait for up to one hour to ensure that the Handheld Management Server has 
received the policy changes, depending on when the last scan was performed. Or, you can 
force an immediate directory scan to ensure that the Handheld Management Server receives 
the new policy changes by right-clicking the ZENworks Handheld Management Service 
object, clicking Actions, then clicking Scan Now.

3. For Palm OS and Windows CE devices, the default Policy Package Schedule is 
EventHandheldSync (whenever the handheld device connects/synchronizes); for BlackBerry 
devices, the default Policy Package Schedule is once per day. If you have changed the default 
Policy Package Schedule, it might take longer to enforce the policy changes on the associated 
handheld devices. In addition, if the handheld devices were unable to connect to the 
ZENworks Handheld Management system (because of connectivity problems, for example), 
you might need to reconnect/resynchronize the devices.

The following sections contain additional information:

“Changing the Handheld Package or Handheld User Package Schedule” on page 62

“Changing an Individual Policy’s Schedule” on page 63

Changing the Handheld Package or Handheld User Package Schedule

1 In ConsoleOne, right-click the Handheld Package or Handheld User Package object, click 
Properties, then click the desired platform page.

2 Click the Edit button in the Default Package Schedule group box.

3 Make the desired changes to the schedule.

Be aware that changing the policy package’s schedule to run too frequently will affect 
performance, depending on your environment. The default schedule should be adequate for 
most situations.
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NOTE: Click the Help button for detailed information about the options in the Edit Policy Package 
Schedule dialog box.

4 Click OK.

Changing an Individual Policy’s Schedule

1 In ConsoleOne, right-click the Handheld Package or Handheld User Package object, click 
Properties, then click the desired platform page.

2 Select the check box under the Enabled column for the desired policy.

This both selects and enables the policy.

3 Click Properties.

4 Click the Policy Schedule tab, then make the desired changes to the schedule.

Be aware that changing the an individual policy’s schedule to run too frequently affects 
performance, depending on your environment. The default schedule should be adequate for 
most situations.
NOTE: Click the Help button for detailed information about the options in the Policy Schedule page.

5 Click OK.

Setting Up Handheld Service Package Policies
The Handheld Service Package currently contains one policy: Handheld Import. Creating the 
Handheld Service Package and configuring and associating the Handheld Import policy are 
covered in “Setting Up Handheld Import” on page 11.

Viewing Policy Status Information
ZENworks Handheld Management lets you view policy status information for each enabled 
policy, including a list of all handheld devices and User objects that a policy is associated with, the 
status of each policy, and the date and time that the policy was last enforced. You can also view 
status information about all policies associated with a specific handheld device.

The following sections contain more information:

“Viewing Status for a Specific Policy” on page 63

“Viewing Policy Status for a Specific Handheld Device” on page 65

Viewing Status for a Specific Policy
1 In ConsoleOne, right-click the Handheld Package or Handheld User Package object, then 

click Properties.

2 Select the check box under the Enabled column for the desired policy.

This both selects and enables the policy.

3 Click Properties.

4 Click the Policy Status tab.
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NOTE: Click Display to refresh the information in the Object, Status, and Last Enforced columns.

Object: Lists the individual handheld device objects that the policy is associated with. You 
can select a handheld device in the list, then click Properties to view that device’s properties.

Status: Lists the status of the policy on each handheld device:

Last Enforced: Lists the date and time that the policy was last enforced.

The Status field at the bottom of the page displays Work Completed if all information has been 
gathered for the policy and for the associated handheld devices. The Status field displays 
Connecting to Server if you click Display. When all information has been gathered, the status 
returns to Work Completed.

Status Description

Successful The policy was successfully enforced on the corresponding handheld device.

Pending The policy has reached its scheduled run time but has not yet reported 
results. For example, the policy has been enforced on the handheld device, 
but the Access Point has not yet connected to the ZENworks Handheld 
Management Server to relay the information.

Failed The policy was not successfully enforced on the handheld device. For 
troubleshooting information, see “Why are policies that I have configured and 
enabled not being enforced on individual handheld devices?” on page 127.

Disabled The policy has been disabled in ConsoleOne. To re-enable a policy, right-
click the Handheld Package or Handheld User Package object, click 
Properties, then select the check box in the Enabled column for the desired 
policy.

Inactive The policy is inactive. For example, the policy has been disassociated with 
the handheld device; however, policy status information still exists in 
ZENworks Handheld Management.
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Viewing Policy Status for a Specific Handheld Device
1 In ConsoleOne, right-click the desired Handheld Device object, then click Properties.

2 Click the down-arrow on the ZENworks tab, then click Policy Status.

NOTE: Click Display to refresh the information in the Object, Status, and Last Enforced columns.

Policy: Lists the individual policies that are associated with the selected Handheld Device 
object. Select a policy in the list, then click Properties to view that policy’s properties.

Status: Lists the status of the policy on each handheld device:

Status Description

Successful The policy was successfully enforced on the corresponding handheld 
device.

Pending The policy has reached its scheduled run time but has not yet reported 
results. For example, the policy has been enforced on the handheld device, 
but the Access Point has not yet connected to the ZENworks Handheld 
Management Server to relay the information.

Failed The policy was not successfully enforced on the handheld device. For 
troubleshooting information, see “Why are policies that I have configured 
and enabled not being enforced on individual handheld devices?” on 
page 127.

Disabled The policy has been disabled in ConsoleOne. To re-enable a policy, right-
click the Handheld Package or Handheld User Package object, click 
Properties, then select the check box in the Enabled column for the desired 
policy.

Inactive The policy is inactive. For example, the policy has been disassociated with 
the handheld device; however, policy status information still exists in 
ZENworks Handheld Management.
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Last Enforced: Lists the date and time that the policy was last enforced.

For most policies, the date and time in the Last Enforced column is based on the handheld 
device's date and time. For File Retrieval policies, the date and time in the Last Enforced 
column is based on the Access Point date and time.

The Status field at the bottom of the page displays Work Completed if all information has been 
gathered for the policy and for the associated handheld devices. The Status field will display 
Connecting to Server if you click Display. When all information has been gathered, the status 
will return to Work Completed.
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3 Using Queries and Groups

After handheld devices have registered with Novell® ZENworks® 6.5 Handheld Management, 
you can use queries to quickly find handheld devices that match criteria specified in the query and 
create custom groups to make managing handheld devices easier.

The following sections contain additional information:

“Using Queries” on page 67

“Using Groups” on page 71

Using Queries
Queries let you quickly find handheld devices that match criteria specified in the query.

Using queries, administrators can save time by automatically creating handheld groups populated 
with handheld devices that have the same attributes.

For example, you can create a group from a query that contains all devices that have:

A specific processor type (for example, Intel* StrongARM)

RAM greater than 8 MB but less than 64 MB

A specific version of an application installed

You can define separate queries for BlackBerry*, Palm OS*, and Windows* CE devices, but you 
cannot create a single query that returns all types of devices.

The following sections contain additional information about creating queries:

“Creating a Query” on page 67

“Using Logical Operators” on page 70

Creating a Query
You create queries in the ZENworks Handheld Management Inventory Viewer.

1 In Novell ConsoleOne®, right-click a handheld device object, then click Actions >Inventory.

2 Click Queries > Add Query to display the Add Query dialog box.
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3 Type a name for the query.

4 Click Palm OS Handhelds in the Query Type drop-down list to create a query for Palm OS 
devices.

or

Click Windows CE Devices in the Query Type drop-down list to create a query for Windows 
CE devices.

or

Click BlackBerry Devices in the Query Type drop-down list to create a query for BlackBerry 
devices.

5 Click the Add Item button above the Query dialog box . 

The following dialog box appears if you are querying on Windows CE devices.

6 Select the first object you want to make part of the query, then click OK.
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The first column lists the attributes you can make part of the query. Click the second column 
to display a down-arrow, click the down-arrow, then select the operator that you want to use. 
When you click the third column, a browse button displays. Click the browse button, then 
select a value for the query. 

7 Select the attributes, operator, and values of the object that you want ZENworks Handheld 
Management to query on, then click OK.

If you want to the query to contain multiple objects, click the Add Item button again to add a 
new object.
NOTE: Select the statements and click the parenthesis button  if you want to group statements using 
parentheses.

When you select multiple attributes to query on, be aware that they will be filtered by the first 
object you pick.

For example, if the first attribute you select is OS Version = 3.5 and the second object you 
select is Free RAM, when you choose a specific value for Free RAM, the only values in the 
list are handheld devices running OS version 3.5.

If you want to review the results of the query that you have defined, click Test. The result is 
displayed in the Test Query dialog box.
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8 Click OK to save the query.

Using Logical Operators
Logical operators in a query allow you to refine or expand the scope of the query. ZENworks 
Handheld Management provides the following logical operators:

If you insert multiple objects for querying, ZENworks Handheld Management automatically adds 
an AND operator between the two object statements.

Understanding the Order of Operations

When evaluating a query, the following order of operations is used:

1. Expressions in parentheses

2. Expressions negated by NOT

3. Expressions joined by AND

4. Expressions joined by OR

Using Groups
Placing devices in groups can save you time when scheduling distributions, defining filters, and 
checking system status. With groups, you can use a single entity to manage multiple devices.

The following sections contain information to help you create and use groups:

“Creating Groups” on page 71

“Viewing the Properties of a Group” on page 75

Operator Description Example

AND Find devices that match the object criteria 
joined by the AND.

All Pocket PC devices AND less than 10 
MB of free RAM.

OR Find devices that match at least one of the 
criteria joined by the OR.

All Pocket PC devices OR all devices with 
more than 8 MB of RAM.

NOT Find devices that match one criteria but 
not another.

All Palm OS devices and NOT with the 
application FileZ installed.
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“Changing Group Membership” on page 77

“Changing the Update Schedule of Query-Based Groups” on page 77

“Deleting a Group” on page 78

“Changing a Group’s Type” on page 80

Creating Groups
You can create custom groups based on the way you manage the handheld devices in your 
organization. For example:

Functional groups: Sales, Marketing, Development, Admin, and so forth.

Geographical location: Central, East, West, Europe, and so forth.

Think about the way you want to manage your handheld devices before you create groups. 
Keeping a clean and uncluttered group structure helps minimize confusion when scheduling 
distributions or defining filters for multiple groups.

ZENworks Handheld Management provides two types of user-created groups:

Static Groups: Handheld devices are assigned to the group manually by the administrator or 
according to the settings specified in the Handheld Import policy.

Query-Based Groups: Handheld devices are automatically placed in a group by ZENworks 
Handheld Management because they meet criteria specified in the query (for example, 
operating system version, manufacturer, and so forth).

Handheld devices can belong to multiple groups; they do not need to be limited to one group.

The following sections contain additional information about creating and viewing groups:

“Creating Static Groups” on page 71

“Creating Query-Based Groups” on page 73

Creating Static Groups

Handheld devices are manually assigned to a static group by the administrator.

To create a static group and assign members to it:

1 In ConsoleOne, click the container where you want to create the static group.

2 Click File > New > Object.

3 Click Handheld Group, then click OK.

4 Specify a descriptive name for the group, select the Define Additional Properties check box, 
then click OK.

5 Select Static Group - Members Updated Manually.
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6 Click the Members tab.

7 Click Add to display the Select Objects dialog box.
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8 Select the handheld device objects that you want to be members of this static group.

You can use Shift+click or Ctrl+click to select multiple handheld device objects.

9 Click OK.

Static groups are indicated by  (yellow folder icon) in the ZENworks Handheld Management 
Inventory Viewer.

Creating Query-Based Groups

Handheld devices are automatically placed in a query-based group by ZENworks Handheld 
Management because they meet criteria specified in the query (for example, operating system 
version, manufacturer, and so forth).

To create a query-based group:

1 In ConsoleOne, click the container where you want to create the query-based group.

2 Click File > New > Object.

3 Click Handheld Group, then click OK.

4 Specify a descriptive name for the group, select the Define Additional Properties check box, 
then click OK.
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5 Select Query-Based Group - Members Are Updated From a Query.

6 In the Service field, browse to the ZENworks Handheld Management Service object.

7 In the Query Name field, browse to the query on which you want to base the group, then click 
OK.

You need to create a query before it will display in the list. For more information, see “Using 
Queries” on page 67.
NOTE: If you define and base a query-based group on a specific query and you later change the name 
of the query in the ZENworks Handheld Management Inventory Viewer, you must re-assign the new 
query to the group (it is not updated automatically). You cannot change the name of a query in 
ConsoleOne. 

8 Select a Group Update Interval:

Use the Default Server Schedule: Select this option if you want the group to be updated with 
new members according to the default server schedule.

The group is populated with handheld device objects during the server’s next maintenance 
scan, which is hourly, by default. You can force an immediate update of a specific query-
based group. 

To do this:

8a In ConsoleOne, right-click the ZENworks Handheld Management Service object, click 
Actions, then click Scan Now. 

This performs the directory scan.

8b Again in the ConsoleOne, right-click the desired Handheld Group object, click Actions, 
then click Update. 

This updates the list of handhelds that belong to this group.

Use a Custom Update Schedule: Select this option if you want to specify a custom update 
schedule, then specify the group update interval.
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9 Click OK.

The query-based group (indicated by  in the ZENworks Handheld Management Inventory 
Viewer) is created and populated with the handheld devices that currently match the criteria 
specified in the query. 

Viewing the Properties of a Group
1 In ConsoleOne, right-click the desired Handheld Group object, then click Properties.

2 Click the Members tab.

From the Members page, you can view which handheld objects are members of the selected 
group.

3 Click the ZENworks tab.
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From the Associated Policy Packages page, you can view which policy packages are 
associated to the selected Handheld Group object.

4 Click the Applications tab.

From the Applications tab, you can view which Handheld Application objects are associated 
to the selected Handheld Group object.
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Changing Group Membership
From time to time you will need to modify static group membership by adding or deleting 
handheld device objects. 

Query-based groups are updated according to the query parameters; membership cannot be 
changed manually without changing the criteria specified in the query.

For example, if you have divided your client groups by functions, and you have a user who 
transfers from Sales to Systems Engineering, you might need to delete the user from one group and 
add the user to another group.

Whenever you add a handheld device to a group, it automatically inherits any distributions 
assigned to that group.

The following sections contain additional information about changing group membership:

“Adding a Device to a Static Group” on page 77

“Removing a Device from a Static Group” on page 77

Adding a Device to a Static Group

1 In ConsoleOne, right-click the desired Handheld Group object, then click Properties.

2 Click the Members tab, then click Add.

3 Select the device you want to include in the group.

You can use Shift+click or Ctrl+click to select multiple handheld device objects.

4 Click OK.

Removing a Device from a Static Group

1 In ConsoleOne, right-click the desired Handheld Group object, then click Properties.

2 Click the Members tab.

3 Select the device you want to remove from this group.

You can use Shift+click or Ctrl+click to select multiple handheld device objects.

4 Click Delete.

Changing the Update Schedule of Query-Based Groups
When you create a query-based group, you can choose how often the group should be updated. 
Updating runs the query against existing handheld devices to check which devices match the 
criteria. Any handheld devices that match the criteria of the query are automatically placed in the 
appropriate query-based group; any handheld devices that no longer match the criteria of the query 
are automatically removed from the query-based group.

By default, query-based groups are updated once an hour. You can configure updating system 
wide so that all groups are updated on the same schedule or on a per-group basis. You can also turn 
off group updating (essentially making the query-based group a static group).

The following sections contain additional information:

“Changing the Update Schedule of a Specific Query-Based Group” on page 78

“Changing the Update Schedule of All Query-Based Groups” on page 78
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Changing the Update Schedule of a Specific Query-Based Group

1 In ConsoleOne, right-click the desired Handheld Group object, then click Properties.

2 On the General page, select Use a Custom Update Schedule, then specify the Group Update 
Interval.

3 Click OK.

If you modify the update schedule, the next maintenance scan (hourly, by default) detects the 
change and reschedule the update accordingly.
NOTE: You can force an immediate update of a specific query-based group. In ConsoleOne, right-click the 
ZENworks Handheld Management Service object, click Actions, then click Scan Now to perform a directory 
scan. Next, right-click the desired Handheld Group object, click Actions, then click Update.

Changing the Update Schedule of All Query-Based Groups

1 In ConsoleOne, right-click the ZENworks Handheld Management Service object, then click 
Properties.

2 Select the desired Group Update Interval.

3 Click OK.
NOTE: You can force an immediate update of a specific query-based group. In ConsoleOne, right-click the 
ZENworks Handheld Management Service object, click Actions, then click Scan Now to perform a directory 
scan. Next, right-click the desired Handheld Group object, click Actions, then click Update.

Deleting a Group
As your installation changes over time, you might want to remove groups based on changes in your 
organization or in the types of equipment you are using, or you might just want to change the 
grouping scheme you’ve implemented.

To delete a group:

1 In ConsoleOne, right-click the desired Handheld Group object, then click Delete NDS object.

2 Click Yes to confirm the deletion.

The Handheld Group object is removed from the directory and its update schedule is removed from 
ZENworks Handheld Management.
NOTE: When you delete a Handheld Group object, the object is deleted but the handheld device objects are 
not deleted from the directory; they simply lose their association with the deleted object and all distributions 
the device inherited that were targeted for the group.

Viewing Handheld Application Objects Assigned to a Group
1 In ConsoleOne, right-click the desired Handheld Group object, then click Properties.

2 Click the Applications tab.
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The Applications list displays the Handheld Application objects that are associated to the 
selected Handheld Group object.

3 To view an application object’s details, click a Handheld Application object, then click 
Details.

The General page displays the application object’s properties, including its description, when 
it becomes available for distribution, and when it is no longer be available for distribution

NOTE: When you are viewing the Handheld Application objects that are associated with a Handheld Group 
object, you only see Handheld Application objects that are associated to that specific group; you do not see all 
Handheld Application objects that are associated with all individual devices in that group.
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Changing a Group’s Type
To change a static group to a query-based group or a query-based group to a static group:

1 In ConsoleOne, right-click the desired Handheld Group object, then click Properties.

2 On the General page, click Static Group or Query-Based Group.

If you choose Query-Based, select the query on which you want to base the group.

3 Click OK.

Because you cannot schedule the update of a static group, if you change a query-based group to a 
static group, the group’s update schedule is removed from ZENworks Handheld Management.
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4 Distributing Software to Handheld Devices

This section describes how to create and distribute Handheld Application objects to handheld 
devices using Novell® ZENworks® 6.5 Handheld Management. 

The following sections contain detailed information:

“Understanding Handheld Application Objects” on page 81

“Distributing Applications to Handheld Devices” on page 82

“Displaying Handheld Application Object Status” on page 89

“Modifying a Handheld Application Object” on page 90

Understanding Handheld Application Objects
ZENworks Handheld Management software distribution allows you to distribute Handheld 
Application objects to handheld devices as part of software distributions. Handheld Application 
objects contain collections of files that you want copied to your handheld devices.

Handheld Application objects usually consist of applications to install on handheld devices, for 
example, .prc files (for Palm OS* devices); .cab files (for Windows* CE devices); and .alx, .ali, 
and .dll files for BlackBerry* devices.

The following sections contain additional information:

“Specifying Source Files” on page 81

“Understanding Automatic Application Updates” on page 82

Specifying Source Files
When creating Handheld Application objects, you can select files, directories (and subdirectories), 
or both as the components of your object. You can also specify wildcard characters as a source file 
specification.

The following sections contain additional information:

“Files for Palm OS Devices” on page 81

“CAB Files for Windows CE Devices” on page 82

“Files for BlackBerry Devices” on page 82

Files for Palm OS Devices

Only standard Palm OS file types should be selected when creating handheld application objects 
targeted for Palm OS devices. Supported file types include:

Application files (*.prc)
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Database files (*.pdb)

Query application files (*.pqa)

Configuration files (*.pnc and *.scp)

CAB Files for Windows CE Devices

Because Windows CE devices support different processor types, ZENworks Handheld 
Management ensures that only CAB files compatible with the processor are copied to the 
Windows CE device when it synchronizes.

If CAB files are included in the handheld application object, they are automatically extracted and 
installed.

Files for BlackBerry Devices

Only standard RIM BlackBerry file types should be selected when creating handheld application 
objects targeted for BlackBerry devices. Supported file types include:

Configuration files (*.alx and *.ali)

Dynamic link library files (*.dll)

ZENworks Handheld Management lets you distribute software to BlackBerry devices that are 
synchronized with a cradle; ZENworks Handheld Management does not support software 
distribution to BlackBerry devices using wireless synchronization.

Understanding Automatic Application Updates
For recurring software distributions (distributions that are scheduled to run more than once, for 
example, weekly), ZENworks Handheld Management automatically scans the application’s 
source directories at the scheduled time and includes new or changed files with the software 
distribution.

This allows an administrator to copy new or updated files to the source directory for distribution 
to handheld devices without needing to create a new Handheld Application object.

For example, you distribute sales data weekly to your sales staff. Each Monday, before sending 
out the distributions, ZENworks Handheld Management scans the application’s source directory. 
If there are any new or changed files added during the previous week, they are included in that 
Monday’s application distribution. The handheld device receives only the files that have changed.

If the source directory has no changes during the week, the application is not sent (unless new 
handheld devices have been added to the list of recipients).

Distributing Applications to Handheld Devices
ZENworks Handheld Management lets you create and distribute Application objects to individual 
handheld devices or to groups of handheld devices.

The following sections contain additional information:

“Creating a Handheld Application Object” on page 83

“Configuring a Handheld Application Object” on page 83

“Scheduling the Distribution of a Handheld Application Object” on page 88
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Creating a Handheld Application Object
1 In Novell ConsoleOne®, right-click the container where you want to create the Handheld 

Application object, click New, then click Object to display the New Object dialog box.

2 Click Handheld Application, then click OK to display the New Application dialog box.

3 In the Name field, type a name for the Handheld Application object, then click OK. 

The object's name must conform to the following rules:

The name must be unique in the container.

Special characters are allowed. However, plus (+), equals (=), and period (.) must be 
preceded by a backslash (\) if used.

Uppercase and lowercase letters, as well as underscores and spaces, are displayed as you 
first entered them, but they aren't distinguished. For example, 
ZENworks_Handheld_Management and 
ZENWORKS_HANDHELD_MANAGEMENT are considered identical.

4 Click OK.

Configuring a Handheld Application Object
1 In ConsoleOne, right-click the newly created Handheld Application object, then click 

Properties to display the General page.
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2 Type a description of the Handheld Application object, if desired.

This description is available by viewing the properties of the object in ConsoleOne; users do 
not see this description during distribution. 

3 If desired, click the Calendar/Clock icon to specify a date and time that the application object 
is available for distribution.

If you do not change this setting, the object is distributed according to the Application object 
schedule. This option lets you delay distribution to the date you specify.

4 If desired, select Expires On, then specify a date and time that the application object is no 
longer be available for distribution.

5 Click the Files tab.
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6 Click Add, then fill in the fields:

Path: Browse to or type the path to the location of the application’s executable file.

Files: Browse to or type the files that you want to include in the Handheld Application object.
TIP: You can use wildcard characters to specify the source files.

Include Subdirectories of This Path: Enable this option if you want to include 
subdirectories of the path.
IMPORTANT: If you want to access application data on a Novell NetWare® volume, you must install the 
Novell ClientTM on the ZENworks Handheld Management Server. You might be able to browse to and 
select application data on the NetWare volume without the Novell Client installed, but the handheld 
application object is not built unless the Novell Client is installed on the ZENworks Handheld Management 
Server.

7 Click OK.

8 In the Destination box, choose a destination for the files from the drop-down list:

Copy the Files to a Windows CE Device: Copies the files contained in the Handheld 
Application object to an individual Windows CE device or to a group of Windows CE 
devices.

Copy the Files to a Palm Device: Copies the files contained in the Handheld Application 
object to an individual Palm OS device or to a group of Palm OS devices.

Copy the Files to a RIM BlackBerry Device: Copies the files (application object) to the 
sync machine and queues the files in the appropriate directory for installation by the 
Application Loader.

Copy the Files to a Temporary Location on the Sync Machine: Copies the files to a 
temporary location on the machine that the handheld device synchronizes with.

Some applications require running Windows desktop routines before installation on Palm 
OS or Windows CE devices. If this is the case, choose Copy the Files to a Temporary 
Location on the Sync Machine so that users can run those routines before installing them 
on the handheld device. The iPAQ ROM update is an example of an application that you 
would use this option for.
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NOTE: If a handheld application object being copied to a Palm OS or BlackBerry device contains a file 
that already exists on the device, ZENworks Handheld Management overwrites the file on the device with 
the file contained in the handheld application object. For Windows CE devices and sync machines, if a 
handheld application object being copied to a device or machine contains a file that already exists in the 
destination path, ZENworks Handheld Management overwrites the file at the target location with the file 
contained in the handheld application object.

If a file is in use on a handheld device or sync machine when a handheld application object that contains 
the same file is being installed, the distribution fails. If you enable automatic updates for the handheld 
application object, the device receives the distribution at its next scheduled time, providing that the file is 
not is use at that time. If the handheld application object is scheduled to run only one time, you must 
resend it when the file is not in use.

9 Windows CE Devices: If you chose Copy the Files to a Windows CE Device, you can specify 
the path on the Windows CE device where you want the files copied to.

or

Palm OS Devices: If you chose Copy the Files to a Palm Device and you have a storage card 
installed, select Install Files on Storage Card, if desired.

ZENworks Handheld Management supports expansion cards in Palm OS devices running 
Palm OS 4.x and later. Expansion cards are usually referred to as secure digital (SD) cards or 
memory sticks.
IMPORTANT: If you select the Install Files on Storage Card option, ZENworks Handheld Management 
installs the files only to a storage card. If the storage card is not available, the installation fails; ZENworks 
Handheld Management does not install the files in the Palm OS device's main memory.

or

Sync Machines: If you chose Copy the Files to a Temporary Location on the Sync Machine, 
specify the command to run, then select Fail Installation if Command Reports Failure, if 
desired. These machines must be running the ZENworks Handheld Management Desktop 
Synchronization Integration or Access Point.

You can specify whether or not dialog boxes display when files contained in this Handheld 
Application object are installed on machines that associated handheld devices synchronize 
with. Click the Display tab to configure these settings. Click Help for more information on 
each option.

or

RIM BlackBerry Devices: If you chose Copy the Files to a RIM BlackBerry Device, you can 
specify whether or not dialog boxes display when files contained in this Handheld Application 
object are installed on desktop computer that associated BlackBerry devices synchronize 
with. For example, you could display a message on the desktop computer to inform users that 
files have been queued and they should run the BlackBerry Application Loader. Click the 
Display tab to configure these settings. Click Help for more information on each option.

9a (Optional) To assign a desktop computer to the selected BlackBerry device, right-click a 
BlackBerry device object, click Properties > Assign Desktop on the General page, select 
the desired desktop computer from the list , then click OK.

Because ZENworks Handheld Management lets you distribute software to BlackBerry 
devices that are synchronized with a cradle (ZENworks Handheld Management does not 
support software distribution to BlackBerry devices using wireless synchronization), this 
association tells the ZENworks Handheld Management Server where to send handheld 
application objects during a distribution. 

IMPORTANT: The Handheld Application object you configured cannot be distributed to handheld 
devices until you associate the object with individual handheld devices or to a group of handheld devices.
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10 Click the Associations tab > Add.

11 Select the handheld devices, User objects, or groups of handheld devices you want to 
distribute the Handheld Application object to, then click OK.

The Handheld Application object is distributed to each handheld device the next time it 
connects or according to the application object’s schedule.

If you are distributing an application, you probably do not want the distribution to recur. If 
you are distributing files, such as marketing information, you can schedule the distribution to 
recur using the Schedule page.

12 Click OK to save your settings.

13 If you chose Copy the Files to a Temporary Location on the Sync Machine or Copy the Files 
to a RIM BlackBerry Device in Step 8 on page 85, click the Display tab.

14 Fill in the fields:

Show Status Dialogs on Desktop Sync Machine: Select this option if you want 
informational dialog boxes to display on desktop computers when application files are 
installed.

Before Dialog: Any information that you type in this text box displays on the dialog box that 
displays on the desktop computer. You can use this text box to provide any additional 
information or instructions that you want users to see when the files are installed.

Automatically Close Dialog and Begin Installation After _ Minutes: Select this option, 
then specify the number of minutes that you want to wait before installing the files. Using this 
option enables installation of the files even if the user is away from his or her desk when the 
files are ready to be installed. 

After Dialog: Type any additional text to display on the dialog box after the files are installed.

Automatically Close Dialog After _ Minutes: Select this option, then specify the number of 
minutes that you want to wait before closing the Installation Complete dialog box.

15 Click OK to save your settings.
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Scheduling the Distribution of a Handheld Application Object
If your handheld application object contains files that you want to redistribute periodically, use the 
Schedule page to schedule its distribution. 

If you want the handheld application object to be distributed only once, you do not need to 
schedule it; the object is distributed the next time the associated handheld devices synchronize.

To schedule the distribution of a Handheld Application object:

1 In ConsoleOne, right-click the Handheld Application object, then click Properties to display 
the General page.

2 Click the Schedule tab.

3 Click Enable Automatic Updates.

If you select this option ZENworks Handheld Management scans the source directory at the 
scheduled time for any additions or changes to the source files. If something has changed, the 
application is pushed out at that time.

4 Specify an update time in the Schedule Update Time field.

5 Select a schedule from the Schedule Type drop-down list:

Daily

Weekly

Monthly

Yearly
NOTE: Click the Help button for detailed instructions about each schedule.

6 Specify the hours and days that you want the schedule to activate.

7 Click OK.
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Displaying Handheld Application Object Status
1 In ConsoleOne, right-click the Handheld Application object, then click Properties to display 

the General page.

2 To view the status of a Handheld Application object, click the Application Status tab.

The results lists the Handheld Application objects distributed by the ZENworks Handheld 
Management service listed in the Service field, the status of each object, and the version 
number of each Handheld Application object.

The status of the application can be any of the following:

Canceled: The distribution of the application was cancelled because the distribution it is 
associated with was deleted.

Failed: The application could not be installed by the device.

Installed: The application was installed without a problem.

Pending: The application has not been distributed yet or results have not yet been made 
available.

Skipped: The device contained the current version of the application or the application 
has not changed.

TIP: You can force an application to be installed on an associated handheld device, even if it has already been 
installed on the device, by using the Resend button on the Application Status page of the application object. 
You cannot force ZENworks Handheld Management to resend an application by deleting the application from 
the handheld device; you must use the Resend button.
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Modifying a Handheld Application Object
You can add or delete components and distribute the changes without creating a new Handheld 
Application object.

The following sections contain additional information about modifying Handheld Application 
objects:

“Modifying the Contents of a Handheld Application Object” on page 90

“Scanning for Updated Components” on page 90

“Deleting a Handheld Application Object” on page 90

“Deleting a Handheld Application Object’s Associations” on page 91

Modifying the Contents of a Handheld Application Object
If you change components of a Handheld Application object (for example, the files that are 
included in the object) or you want to change the object’s associations, you can modify the object 
using ConsoleOne; you do not need to create a new Handheld Application object.

To modify the contents a Handheld Application object, follow the steps in “Configuring a 
Handheld Application Object” on page 83, modifying the settings as appropriate.

Scanning for Updated Components
For recurring distributions of Handheld Application objects, ZENworks Handheld Management 
scans component directories at the scheduled time to see if their contents have changed before 
sending out the distribution. Therefore, recurring distributions send out the most recent versions 
of files that make up the application.

For example, if you add or replace files in the source directory for the application, those files are 
included the next time the Handheld Application object is scheduled to be distributed. You do not 
need to create a new Handheld Application object to include the files. See “Understanding 
Automatic Application Updates” on page 82 for an example of how ZENworks Handheld 
Management automatic updates work.

You can also force a source directory to be scanned. 
IMPORTANT: Because the ZENworks Handheld Management Server scans component directories for 
recurring distributions, the ZENworks Handheld Management Server service account must have proper rights 
to access the component directories.

To force a source directory scan immediately and distribute the Handheld Application object if the 
directory has changed:

1 In ConsoleOne, right-click the desired Handheld Application object, then click Actions.

2 Click Update Now.

Deleting a Handheld Application Object
If you decide that you do not want to distribute a specific Handheld Application object again, you 
can delete its object from the directory using ConsoleOne.

1 In ConsoleOne, right-click the desired Handheld Application object, then click Delete NDS 
Object.

2 Click Yes to confirm the deletion.
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Deleting a Handheld Application Object’s Associations
If you decide that you do not want to distribute a specific Handheld Application object to a 
handheld device, User object, or to a group of handheld devices, but you want to keep the object 
in the directory for future use, you can delete the object’s associations.

1 In ConsoleOne, right-click the appropriate Handheld Application object, then click 
Properties.

2 Click the Associations tab, select the handheld devices or groups you want to remove the 
association from, then click Delete.

Removing an association from a handheld device does not remove that application from the 
handheld device.

3 Click OK.
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5 Using Inventory and Reports

After you install the Novell® ZENworks® 6.5 Handheld Management software, set up Handheld 
Import, and users have synchronized their handheld devices, you are ready to collect software and 
hardware inventory for all managed handheld devices in your ZENworks Handheld Management 
system.

Managing software and hardware assets is a critical function for most companies. ZENworks 
Handheld Management inventory capabilities capture asset information to support analysis, 
troubleshooting, and planning.

ZENworks Handheld Management lets you collect and view software and hardware inventory 
information for Palm* OS*, Windows* CE (including Pocket PCs), and BlackBerry* handheld 
devices.

During the ZENworks Handheld Management Server installation, if you selected the "Internal 
ODBC-Compatible Database" option, then you must set the path for database files in the 
ZENworks Handheld Management service object.

To set the path for database files in the ZENworks Handheld Management service object:

1 In Novell ConsoleOne®, right-click the ZENworks Handheld Management service object, 
then click Properties.

2 Click the General tab.

3 In the Remote Path section, add the Complete path to the ZENworks Handheld Management 
server installation folder share. For example, \\myZfHServer\ZfH.

Make sure that this share has the Read-Write permission for the user who has launched 
ConsoleOne.

Using ZENworks Handheld Management, you can do the following:

View software inventory information across all your handheld devices or on a per-device 
basis to ensure software licensing compliance

Plan for software and hardware upgrades with a complete view of application versions and 
hardware configurations

Troubleshoot problems with a thorough knowledge of each handheld device’s hardware and 
software

The following sections contain additional information:

“Viewing Software Inventory” on page 94

“Viewing Hardware Inventory” on page 104

“Viewing Network Information” on page 106

“Using Inventory Reports” on page 106

“Printing Data from the ZENworks Handheld Management Inventory Viewer” on page 110
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Viewing Software Inventory
Software inventory is collected once a day from the handheld device. Software inventory data is 
displayed in the ZENworks Handheld Management Inventory Viewer.

ZENworks Handheld Management lets you collect and view software inventory information for 
Palm OS, Windows CE (including Pocket PCs), and BlackBerry devices.

To view software inventory:

1 In ConsoleOne, right-click a handheld device object, then click Actions >Inventory.

2 Click the Software Inventory tab.

The Software Inventory list in the left frame contains directories named Palm Applications, 
BlackBerry Applications, and Windows CE Applications. You can expand these directories to 
display a list of all the applications found on all handheld devices in your system.

If ZENworks Handheld Management cannot identify an application on a Windows CE device, the 
application is listed in the Unidentified Windows CE Files tree in the Software Inventory list in 
the left frame.

The right frame contains a Name column that lists each application in alphabetical order by 
company name and a Version column that lists each application’s version number.
NOTE: For BlackBerry devices, ZENworks Handheld Management collects software inventory only for 
applications that display on the device’s Options > Status screen.
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The following sections contain additional information:

“Viewing Software Inventory for a Specific Handheld Device” on page 95

“Viewing Software Inventory Across All Palm OS, BlackBerry, or Windows CE Devices in 
Your System” on page 95

“Identifying Files for Windows CE Devices” on page 97

“Ignoring or Identifying Windows CE Files and Applications” on page 99

Viewing Software Inventory for a Specific Handheld Device
ZENworks Handheld Management lets you view the applications installed on a specific Palm OS, 
BlackBerry, or Windows CE handheld device. You can also view application details about a 
specific application on any handheld device in your system.

To view software inventory for a specific device:

1 In ConsoleOne, right-click any handheld device object, then click Actions > Inventory to open 
the ZENworks Handheld Management Inventory Viewer.

2 Click the Clients tab, then expand the ZENworks Handheld Management Groups directory.

3 Expand the desired platform directory in the tree: All BlackBerry Devices, All Palm OS 
Handhelds, or All Windows CE Devices.

4 Click the handheld device whose software applications you want to view.

5 Click the SW Inventory tab in the right pane.

Depending on which platform you chose in Step 3, the information displayed in the SW 
Inventory page varies.

Palm OS Devices: Lists the application name, version, creator ID, and whether the 
application is installed in ROM, RAM, or on a storage card.

BlackBerry Devices: Lists the application name and version.

Windows CE Devices: Lists the name of the company that created the application, the 
application name, and the version.
NOTE: You can determine when the last inventory scan was performed by looking at the Last Software 
Inventory information at the bottom of the dialog box.

6 To view details about a specific application, double-click the application.

The View Application Details dialog box displays the application’s size, creation date, backup 
date, and more.

Viewing Software Inventory Across All Palm OS, BlackBerry, or Windows CE 
Devices in Your System

ZENworks Handheld Management lets you view software inventory information across all of the 
Palm OS, BlackBerry, or Windows CE devices in your system. Suppose, for example, that you 
want to ensure licensing compliance for a certain application. ZENworks Handheld Management 
helps you determine how many copies of that application users have installed on individual 
devices in your organization. You can also display a list containing the name of each device that 
has the application installed.
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To view software inventory information for all Palm OS, BlackBerry, or Windows CE devices in 
your system:

1 In ConsoleOne, right-click any handheld device object, then click Actions > Inventory to open 
the ZENworks Handheld Management Inventory Viewer.

2 Click the Software Inventory tab on the left side of the dialog box, then expand the desired 
platform folder in the tree: Palm Applications, BlackBerry Applications, or Windows CE 
Applications.

If you expand the Windows CE Applications folder, you also need to expand the company 
folder.

3 Click the application whose details you want to view.

4 Click the General tab to view the application’s details, which vary depending on the platform.

Palm OS Applications: Lists the application’s name, the version, the Creator ID, the icon 
name, and how many installations of the application exist on the Palm OS devices in your 
system.

BlackBerry Applications: Lists the application’s name and its version, and the total number 
of copies installed.

Windows CE Applications: Lists the application’s name, version, company name, the files 
that make up the application, and the total number of copies installed.

5 Click the Clients tab in the right frame to view all the handheld devices in your system that 
have the selected application installed and to list additional details, depending on the platform.

Palm OS Devices: Lists information about the individual devices that the selected application 
is installed on, including the name of the device, where the application is installed (RAM, 
ROM, or on a Storage Card), the application’s size, create date, modify date, and record count.

BlackBerry Devices: Lists information about the individual devices that the selected 
application is installed on, including the name of the device, the application’s size, and more.

Windows CE Devices: Lists information about the individual devices that the selected 
application is installed on, including the name of the device, the last time the application was 
scanned, and the installation path on those devices.

For Windows CE applications, you can also view file details if you want to know details about a 
specific file that is part of an application (for example, to determine the version of a specific 
executable file you are running).

1 Click the Software Inventory tab in the left frame.

2 Click the General tab in the right frame.

3 Double-click the application file in the Application Files list box. 
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The File Properties dialog box provides a quick snapshot of information about the file. 

Click the following tabs to view information about the selected file:

General: Lists all application version information, including filename, modify time, and 
file size.

Clients: Lists the Windows CE devices that the file is installed on.

Rules: Lists the Identification and Ignore rules created for the file. For more information, 
see “Viewing Windows CE Identified and Ignored File Rules” on page 103.

Identifying Files for Windows CE Devices
If a Windows CE application file does not have any product information associated with it, 
ZENworks Handheld Management considers it “unidentified” and stores it in the Unidentified 
Windows CE Files folder.

There may be some unidentified files that you want ZENworks Handheld Management to 
recognize as valid applications whenever ZENworks Handheld Management finds the files on a 
device. For these files, ZENworks Handheld Management allows you to specify the product, 
company, and version information so that the files are identified as applications.

When you identify files, an identification rule is created for the files. After they are identified, the 
files appear in the Windows CE Applications folder (with a list of the devices it is found on). The 
files are then removed from the list of unidentified files.

To make an unidentified file a known application:

1 In ConsoleOne, right-click a handheld device object, click Actions > Inventory.
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2 Click the Software Inventory tab, then click the Unidentified Windows CE Files icon (the 
question mark).

A list of unidentified files displays in the right pane.

3 Double-click the file you want to identify, then click Identify File.
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4 Specify the name of the application you want this file to identify with, the version, and the 
company name.

If desired, change the modify time and size for the identification rule.

If you specify a different size and/or date, only files matching those exact specifications are 
identified as a known application. Versions of the file not matching the criteria still appears 
as unidentified.

5 Click OK.

The file will now appear as an application in the Windows CE Applications folder in the tree.

Ignoring or Identifying Windows CE Files and Applications
ZENworks Handheld Management by default ignores some Windows CE application files so the 
application view remains manageable. Ignored files appear in the Ignored Windows CE Files 
folder in the Software Inventory page and in the Ignored Files tab in the Clients page.

The following sections contain additional information:

“Ignoring Windows CE Files” on page 99

“Ignoring Windows CE Applications” on page 101

“Identifying Ignored Windows CE Files” on page 102

“Viewing Windows CE Identified and Ignored File Rules” on page 103

Ignoring Windows CE Files

To keep your list of unidentified files more manageable, you can ignore unidentified files that you 
are not going to identify as applications.

Ignoring these files keeps your unidentified files list smaller, which might help you to recognize 
when ZENworks Handheld Management encounters new unidentified files during software 
inventory.

To ignore unidentified files:

1 In ConsoleOne, right-click a handheld device object, click Actions > Inventory.
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2 Click the Software Inventory tab, then click the Unidentified Windows CE Files icon (the 
question mark).

3 Double-click the file in the right pane.

4 Click Ignore File.

5 Select Ignore All Versions of this File.

or

Select Ignore Only Files with the Following Settings, then specify the modify time and size 
settings as appropriate.

6 If desired, type a description of why you are ignoring the file.

7 Click OK.

The file appears in the Ignored Windows CE Files tree view.
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Ignoring Windows CE Applications

To keep your Applications folder manageable, you can ignore applications. This allows you to 
view only the applications that you think are important to display.

For example, you might want to ignore any applications that are by default included with the 
operating systems (for example, Microsoft Clock).

To ignore an application:

1 In ConsoleOne, right-click a handheld device object, then click Actions > Inventory.

2 Click the Software Inventory tab > the application you want to ignore.

NOTE: You can ignore Windows CE applications only; you cannot ignore Palm OS and BlackBerry 
applications.

3 Click Operations > Ignore Application.

The Ignore Application dialog box lists files that are ignored.
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4 If desired, type a description of why you are ignoring the files.

The description is stored with the file and can be viewed with the rule created for the file. For 
more information, see “Viewing Windows CE Identified and Ignored File Rules” on 
page 103.

5 Click Ignore.

The application files are stored as Ignored files. Any files that future software inventory 
collections find that match the criteria you specified are also stored as Ignored files.
NOTE: Ignoring applications ignores files that are currently known that identify themselves with the ignored 
application. If new files appear that identify themselves as this application, the application reappears in the 
Applications view.

Identifying Ignored Windows CE Files

You can identify ignored application files that you want to be recognized as applications. 

To identify ignored files:

1 In ConsoleOne, right-click a handheld device object, click Actions > Inventory.

2 Click the Software Inventory tab > the Ignored Windows CE Files icon.

3 Double-click the file you want to identify, then click Identify File.

4 Specify the name of the application you want this file to identify with, the version, and the 
company name.

5 If desired, change the modify time and size for the identification rule.

If you specify a different size and/or date, only files matching those exact specifications are 
identified as a known application. Versions of the file not matching the criteria still appear as 
unidentified.

6 Click OK.
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Viewing Windows CE Identified and Ignored File Rules

When you identify or ignore a Windows CE file or application, a rule is created for the file. 

You can view all the rules you have created by clicking Configure > Software Inventory Rules in 
the ZENworks Handheld Management Inventory Viewer.

A rule applies to a file name, not to versions, so you might see rules even if you did not create the 
rule for a specific version of a file you are viewing. Another rule could have been created for a file 
that had a different time stamp or size but the same name.

When you identify or ignore all versions of a file, the size and modify time fields display Any. 
When you identify or ignore a specific version of a file, the size and modify time fields match the 
file you have created the rule for.

If you attempt to create a rule for a file that matches an existing rule, you are warned before 
overwriting the existing rule. The same thing happens if you try to create an ignore rule for a file 
that already has an identification rule.

To view all rules an administrator has created in ZENworks Handheld Management:

1 In ConsoleOne, right-click a handheld device object, then click Actions > Inventory.

2 Click Configure > Software Inventory Rules.

The Software Inventory Rules dialog box lists any files you have identified or ignored.

You can change any rule by selecting the rule, then clicking Edit. You can also identify or 
ignore a file by clicking Add, then creating the rule. You can even create a rule for files that 
have not been installed on your devices yet.

To view rules for a specific file:

1 In ConsoleOne, right-click a handheld device object, then click Actions > Inventory.

2 Double-click an unidentified or ignored file.
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3 Click the Rules tab.

All user-defined ignore and identification rules that match the name of the file appear.

Viewing Hardware Inventory
ZENworks Handheld Management collects hardware information from each handheld device in 
your system, including the model, OS version, processor type, free RAM, RAM used, battery type 
and remaining charge on the battery.

Collected data about hardware is stored on a per-device basis and is found on the ZENworks 
Inventory page in ConsoleOne or on the Clients: Hardware Inventory page in the Inventory 
Viewer.

Hardware inventory data is collected every time the handheld device connects to the Access Point.

To view hardware inventory using ConsoleOne:

1 In ConsoleOne, right-click a handheld device object, then click Properties.

2 Click the ZENworks Inventory: Hardware Inventory tab.

The device’s hardware inventory information is displayed. The Last Hardware Inventory box 
displays the date and time that hardware inventory was last collected for the device.

To view hardware inventory using the ZENworks Handheld Management Inventory Viewer:

1 In ConsoleOne, right-click a handheld device object, click Actions > Inventory.

2 Click the Clients tab, select a handheld device object, then click the HW Inventory tab in the 
right pane.
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Viewing Network Information
You can view a list of network adapters that were found on handheld devices in your ZENworks 
Handheld Management installation.
NOTE: For Pocket PCs, network information is not available for devices running Pocket PC 2000; network 
information is available for devices running Pocket PC 2002 and later. For handheld PCs, network information 
is not available for devices running Windows CE 2.11 or 3.0. For Palm OS devices, network information is not 
available for devices running Bluetooth*.

To view network information from ConsoleOne:

1 In ConsoleOne, right-click a handheld device object, then click Properties.

2 Click the ZENworks Inventory: Network Information tab.

To view network information using the ZENworks Handheld Management Inventory Viewer:

1 In ConsoleOne, right-click a handheld device object, click Actions, then click Inventory.

2 Click the Clients tab, select a handheld device object, then click the Network tab in the right 
pane (this tab only displays if there is network information available the selected handheld 
device).

Using Inventory Reports
You can generate reports about the hardware and software on your handheld devices to make it 
easy to see the applications you have installed, which devices need upgrades, which hardware 
components are installed, and more.

ZENworks Handheld Management provides predefined reports for information stored in the 
ZENworks Handheld Management database, including:

Handheld Application objects (status, run time, and so forth)
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Devices (groups belonged to, distributions run, hardware/software inventory)

Groups

Software inventory (list of all software applications and where they are installed, unidentified 
files, and so forth)

Hardware inventory

After they are generated, reports can be viewed online, sent to a printer, or saved to a file in a 
variety of formats.
TIP: ZENworks Handheld Management is compatible with the Seagate* Software Crystal Reports* reporting 
engine. Using Crystal Reports, you can create your own custom reports. See your Crystal Reports 
documentation for further details.

The following sections contain more information about using reports:

“Running Reports” on page 107

“Exporting Reports” on page 108

“Creating Custom Reports” on page 108

Running Reports
You generate and view ZENworks Handheld Management reports in the ZENworks Handheld 
Management Inventory Viewer.

1 In ConsoleOne, right-click a handheld device object, click Actions > Inventory.

2 Click Reports > the type of report to generate.

After choosing a report, you might be prompted to pick a device or group before generating 
the data. After the report is generated, a screen similar to the following displays.

After the report is generated, you can scroll through the report, print it, or export it to many 
different formats including Excel, HTML, RTF, and so forth. The following illustration shows 
the toolbar buttons you can use to view and print the report.
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Exporting Reports
After you generate a report you can export the report to a file or import the data into a database or 
spreadsheet.

Reports can be exported to formats such as HTML, tab/comma-delimited text files, Microsoft 
Excel, and so forth. After choosing the export format, you can choose the destination, such as a 
file, a Lotus Notes* database, or an e-mail system.

To export a report: 

1 Click  on the toolbar.

2 Choose the format in which to export the report.

3 Select the destination for the report.

4 Click OK.

You are prompted for additional information based on the format and destination.

Creating Custom Reports
Users who have Crystal Reports can create their own custom reports from the ZENworks 
Handheld Management server database. 

The ZENworks Handheld Management server database can be either Microsoft Access* or MS 
SQL, depending on the database type you selected during the installation of the ZENworks 
Handheld Management server components. If you selected the "Internal ODBC-Compatible 
Database" option during the installation, the Handheld Management server database is the 
Microsoft Access database (serverdata.mdb) located in the Handheld Management server 
installation directory (by default, c:\progam files\novell\zfh). If you selected the “Microsoft SQL 
Server” option, the MS SQL Handheld Management server database is located in the path 
specified during the installation. For more information, see “Installing the ZENworks Handheld 
Management Server” in “Installing ZENworks Handheld Management” in the Novell ZENworks 
6.5 Handheld Management Installation Guide.
IMPORTANT: If you create custom reports, the reports must be stored in a shared path if you want them to 
be accessed by a remote ConsoleOne installation. When saving a custom report, specify a UNC path to the 
share (do not use local drive letters).
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To create a custom report:

1 In ConsoleOne, right-click a handheld device object, click Actions > Inventory.

2 Click Reports > Custom Report.

3 Click Add.

4 Type a name for the report.

5 Specify a location for the report you created, then click OK.

6 Click Run to generate the report. 

The report displays similar to any standard report.

Printing Data from the ZENworks Handheld Management Inventory 
Viewer

You can print data from most views in the ZENworks Handheld Management Inventory Viewer.

1 In ConsoleOne, right-click a handheld device object, then click Actions > Inventory.

2 Click the tab from which you want to print data.

3 Click File > Print.
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6 Making System Configuration Changes

This section discusses how to make configuration changes to your Novell® ZENworks® 6.5 
Handheld Management system. 

The following sections contain additional information:

“Configuring User Authentication” on page 109

“Configuring the Proxy Service” on page 111

“Converting to Microsoft SQL Server” on page 116

“Compacting and Repairing the Database” on page 118

“Configuring the Access Point and the Desktop Synchronization Integration” on page 120

“Configuring the ZENworks Handheld Management IP Clients” on page 121

Configuring User Authentication
In previous versions, ZENworks Handheld Management let you manage by handheld device only. 
With ZENworks 6.5 Handheld Management, you can manage by both device and user (similar to 
ZENworks Desktop Management). If user-based management is enabled, users are prompted for 
their credentials and ZENworks Handheld Management authenticates the users using LDAP to log 
in to the directory.

During installation, you can configure user-based management of all of your handheld devices in 
your ZENworks Handheld Management system. For more information, see “Installing the 
ZENworks Handheld Management Server” in the Novell ZENworks 6.5 Handheld Management 
Installation Guide.

You can also configure user-based management by following the procedure in this section to edit 
the properties of the ZENworks Handheld Management Service object.
NOTE: If you do not want to enable user authentication for all handheld devices in your ZENworks Handheld 
Management system, you can choose to not enable global user authentication during installation or by 
following the procedure in this section. You can then configure either the Palm Client Configuration policy or 
the WinCE Client Configuration policy to target only specific handheld devices or groups of handheld devices.

If user authentication is enabled, the user is prompted for his or her credentials (username and 
password) the first time the device connects/synchronizes. ZENworks Handheld Management 
then authenticates the user using LDAP to login to the directory. After the user is authenticated, 
you can target policies and applications to the user of the handheld device. 

The user must enter the credentials only once; ZENworks Handheld Management does not prompt 
the user for the credentials again. If a user who has been authenticated gives the device to another 
person, you should reconfigure the user on the device using ZENworks Handheld Management 
console on the device.
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If the device uses the Palm* IP or Windows* IP client to connect, the user-authentication dialog 
box displays on the handheld device. If the device uses Palm HotSync, the user-authentication 
dialog box displays on the desktop computer during synchronization.

When the user is prompted for authentication, if he or she clicks Cancel, the handheld device can 
be managed by device, but user-based management does not function because the user is not 
authenticated. If the user mis-types the username or password, he or she is immediately prompted 
for the credentials again.
NOTE: There are two places in ZENworks Handheld Management where users can be required to enter a 
password: to authenticate to the directory as part of the Palm Client Configuration policy and to power on a 
handheld device as part of the Palm Security policy. These two passwords are independent of each other. For 
more information about the password users must enter to power on a device, see “Palm Security Policy” on 
page 43.

To configure user authentication for all handheld devices in your system after installation:

1 In Novell ConsoleOne®, right-click the ZENworks Handheld Management Service object, 
then click Properties.

2 Click the User Authentication tab.

3 Select the Enable User Authentication on Handhelds check box.

Checking this option forces all managed handheld devices to prompt users for user credentials 
when the handheld device connects/synchronizes. After user credentials are entered, the 
ZENworks Handheld Management Access Point (on the ZENworks Handheld Management 
Server or on another machine) authenticates the user with the directory.

4 Click Add to open the Select Objects dialog box.

5 Specify the containers that the ZENworks Handheld Management Access Point should search 
when authenticating users, then click OK.

Be aware that subcontainers are not searched. You must specify each user container or 
subcontainer individually.

6 Click the General tab, then click Scan Now to immediately force a scan so that the changes 
you made to the Service object are sent to the ZENworks Handheld Management Server.

7 Click OK.
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Configuring the Proxy Service
The proxy service is installed along with the Access Point Software and the Desktop 
Synchronization Software. The proxy service manages application delivery, monitors application 
distributions sent by the ZENworks Handheld Management server, and sends the results of those 
distributions back to the server. The proxy service also queues the policies and ensures that they 
are delivered to handheld devices.

The proxy service starts and runs in the background each time the computer is started. On 
Windows NT*/2000/XP machines, the proxy service runs as a service.

You can the Proxy Console utility to configure the communication mechanism that the proxy uses 
to talk to the Zenworks Handheld Management Server. The proxy service has configuration 
settings for which ZENworks Handheld Management server it should communicate with and 
options for dial-up networking and message transfers.

To make configuration changes to a proxy service on a Windows 2000 machine, the user must be 
at least a Power User on the machine.

The following sections contain additional information:

“Configuring Network Settings” on page 111

“Configuring Network Usage Restrictions” on page 112

“Configuring Dial-Up Communications” on page 113

“Enabling or Disabling Message Transfers” on page 114

“Connecting to the ZENworks Handheld Management Server” on page 115

Configuring Network Settings
1 Run console.exe from the zfhap directory (by default, program files\novell\zfhap).

2 Click Operations > Configure > Server Communications.
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Alternate addresses can be defined for the server when the server is on a network that defines one 
set of IP addresses for internal traffic and another set of IP addresses for traffic from outside of the 
firewall, for instance when you are using Network Address Translation (NAT).

To configure HTTP/SSL settings, see Appendix B, “Configuring SSL and HTTP Settings,” on 
page 131.

Configuring Network Usage Restrictions
Network usage restrictions allow you to pick how TCP/IP connections are made by the proxy 
service and to set bandwidth limitations. In most situations, the default settings should be 
sufficient.

To configure network usage restrictions:

1 Run console.exe from the zfhap directory (by default, program files\novell\zfhap).

2 Click Operations > Configure Communications.

3 Click Network Usage Restrictions in the Network Settings page.
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4 Specify the settings in the fields:

LAN Adapter: The proxy service tries to make a TCP/IP connection to the ZENworks 
Handheld Management server using the installed LAN adapter (this is how a normal 
connection would be made by a proxy service directly connected to the LAN).

Because the proxy service periodically tries to connect to the server, this option should be 
disabled if there is no way to connect to the ZENworks Handheld Management server via the 
LAN. For example, if the user is in a remote office that never directly connects to the LAN 
but has a LAN adapter installed.

Dial-Up Phone Book Entries: Lists the current dial-up networking connections that have 
been configured on the proxy service.

You might want to disable a dial-up connection in order to limit the bandwidth used by a 
specific connection. For example, you might not want ZENworks Handheld Management to 
use a dial-up connection that is used strictly for a cellular modem.

Dial-Up Bandwidth Usage: Allows you to set how much bandwidth ZENworks Handheld 
Management can use when transferring messages over dial-up connections. By default, proxy 
services uses the maximum bandwidth available.

On occasion, the user might want to limit the bandwidth ZENworks Handheld Management 
uses, especially if other processes are using the dial-up connection at the same time 
ZENworks Handheld Management is transferring messages. 

For example, if users are downloading large files from the network, they might want to limit 
the amount of bandwidth ZENworks Handheld Management is using so that the file download 
finishes faster. If necessary, you can also disable message transfers to keep ZENworks 
Handheld Management from sending messages. For more information, see “Enabling or 
Disabling Message Transfers” on page 114.

Configuring Dial-Up Communications
You can configure the proxy service to automatically attempt to connect to the server using a dial-
up connection.

When dial-up networking is configured, the proxy service automatically attempts to dial up the 
ZENworks Handheld Management server to exchange messages. You can configure the frequency 
of dial-ups and how long to wait for the next dial-up after the client has connected.
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Before setting up the proxy service to use dial-up networking, the proxy service must have a valid 
phone book entry in the Dial-Up Networking folder on the client. This entry should connect you 
to a server that gives you access to the server. 

To configure the proxy service to use dial-up networking:

1 Run console.exe from the zfhap directory (by default, program files\novell\zfhap).

2 Click Operations > Configure > Server Communications.

3 Click Dial-Up Settings.

4 Select the Use Dial-Up Networking When Not Docked on LAN check box.

5 Select a phone book entry from the drop-down list.

6 To configure how frequently the proxy service attempts to dial up the server, select Only Dial 
Up After Not Connecting for _ Days, then specify the number of days.

7 To configure when the proxy service should attempt to dial up the server, configure the 
schedule in the Allow Dial-Up group box.

8 To configure details of the dial-up, such as logon information, select Advanced Dial-Up 
Settings, make any configuration settings, then click OK.

9 Click OK.

Enabling or Disabling Message Transfers
Message transfers enable the proxy service to send messages to the ZENworks Handheld 
Management server. Normally, you should always leave message transfers enabled.

To enable/disable message transfers:

1 Run console.exe from the zfhap directory (by default, program files\novell\zfhap).

2 To enable transfers, click Operations > Enable Message Transfers.

or

To disable transfers, click Operations > Disable Message Transfers.

By default, message transfer is enabled and new messages are automatically placed in the proxy 
service’s message queue or out box.
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Configuring Handheld Communications
You can configure the settings used by the IP client on the handheld to communicate with the 
Access Point.

1 Start console.exe from the zfhap directory.

2 Click Options > Configure > Handheld Communications.

3 In the Handheld Communication Settings dialog box, configure the following options:

If you want the handheld to use HHTP, select the Enable HTTP Encapsulation check box.

If you want the handheld to use SSL, select the Enable SSL check box.

If you want the handheld to communicate with SSL over HTTP, select both the Enable 
HTTP Encapsulation and the Enable SSL check boxes.

If you want the handheld to connect to a port other than the default, deselect the Use 
Default Port check box and specify the port the handheld should use to connect to the 
Access Point.

Configuring IP Communication for the Access Point
To configure the Access Point communication, click Options > Configure > Access Point 
Communications.

Alternatively, you can configure Access Point communication by launching cfgip.exe from the 
zfhap directory. For more information, see “Configuring the SSL and HTTP Communication 
between the ZENworks Handheld Management Server and the Access Point” on page 132.

Connecting to the ZENworks Handheld Management Server
You can ensure that the proxy service can locate the ZENworks Handheld Management server and 
exchange messages by using the Connect to Server option in the Operations menu of the proxy 
service console.

When you use this option, the proxy service attempts to connect to its assigned server, and, if the 
server is found, it forwards any pending messages to the server.

To force a connection to the ZENworks Handheld Management server:
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1 Run console.exe from the zfhap directory (by default, program files\novell\zfhap).

2 Click Operations > click Connect to Server.
TIP: If the Connect to Server option is not available, the proxy server is not running.

If the server cannot be found, ensure that the ZENworks Handheld Management server service is 
running on the ZENworks Handheld Management server machine and that you are properly 
connected to the network.

Converting to Microsoft SQL Server
If you configured the ZENworks Handheld Management Server to use the internal ODBC-
compatible database, you can upgrade to a Microsoft* SQL Server database if you have Microsoft 
SQL Server installed.

To convert the internal ODBC-compatible database to Microsoft SQL Server:

The ZENworks Handheld Management Server machine must be able to access the Microsoft 
SQL Server machine on the network.

The person logged in when running the SQL conversion tool must have a server role of 
System Administrator to convert the database.

After the database is successfully upgraded, the System Administrator permission can be removed. 
The ZENworks Handheld Management Server user and the user running the ZENworks Handheld 
Management console just need database access of db_datareader and db_datawriter.

To convert the database to Microsoft SQL Server:

1 Use either Windows Explorer or the command prompt on the ZENworks Handheld 
Management installation machine to access the ZENworks Handheld Management Server 
installation directory.

2 From the installation directory, run sqlconv.exe (by default, in program files\novell\zfh) to 
open the SQL Server Converter wizard.

3 Click Next.

4 Type the name of the machine where Microsoft SQL Server is installed, then click Next. 
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5 Type the name you want to assign to the ZENworks Handheld Management database when it 
is created in SQL, then click Next.

This page shows the name of the SQL Server machine and the name you are assigning to the 
database.

6 Click Finish to convert your current ZENworks Handheld Management database to an SQL 
Server database.

The time it takes for the database conversion depends on the size of the database and number 
of records to process. 

Compacting and Repairing the Database
As the number of distributions you run increases, the size of the databases at the server and on the 
proxy service computers grows.

ZENworks Handheld Management provides separate tools to reduce the size of the server and 
proxy service databases.
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The ZENworks Handheld Management tools to compact and repair the server database are for the 
internal ODBC-compatible databases only. If you have configured ZENworks Handheld 
Management to use Microsoft SQL Server, use the utilities provided with Microsoft SQL Server 
to perform database maintenance.

The following sections contain additional information:

“Compacting the Server Database” on page 118

“Compacting the Proxy Service Database” on page 119

“Compacting and Repairing the Database” on page 119

Compacting the Server Database
Before performing database operations, you should back up the ZENworks Handheld 
Management installation directory (specifically serverdata.mdb).

Before compacting a server database, make sure to shut down all ZENworks Handheld 
Management applications, including ConsoleOne.

Make sure that no other computer is accessing the database (for example, a remote copy of 
ConsoleOne).

If another computer has the database locked, you will receive in an error message if you try the 
operation. Shut down the ConsoleOne on that computer and retry the operation.

To compact the server database:

1 Use either Windows Explorer or the command prompt on the ZENworks Handheld 
Management installation machine to access the ZENworks Handheld Management Server 
installation directory.

2 From the installation directory, run dbtool.exe.

3 If you are sure no other process is accessing the database (for example, a remote installation 
of ConsoleOne), click OK.

The database is compacted and the service is restarted.

Compacting the Proxy Service Database
The proxy service database can be compacted by using dbtool.exe from the command line in the 
client installation directory (program files\novell\zfhap).

To compact a proxy service database:

1 Use either Windows Explorer or the command prompt on the ZENworks Handheld 
Management proxy service machine to access the ZENworks Handheld Management client 
installation directory.

2 From the installation directory, run dbtool.exe.

You will be reminded that the ZENworks Handheld Management client will be stopped and 
restarted after the database is compacted. 

3 Click OK.
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Compacting and Repairing the Database
If the server internal ODBC-compatible database or proxy service database cannot be opened 
when ZENworks Handheld Management or the proxy service starts, you might need to compact 
and repair the database. 

If the database is corrupt, you might see a message in the log file that indicates that the database 
could not be opened. To compact and repair the database, you need to use the dbtool command 
with the /compact option. Other dbtool options are described below.

For example, to repair a proxy service database, enter:

dbtool /proxy /compact

Dbtool.exe is installed in the zfh and zfhap installation directories.

Configuring the Access Point and the Desktop Synchronization 
Integration

The IP conduit is used by ZENworks Handheld Management IP service clients to transfer 
messages. It is installed when the ZENworks Handheld Management Server or Access Point is 
installed. For more information, see “Installing the Access Point on Additional Computers” in 
“Installing ZENworks Handheld Management Server Components” in “Installing ZENworks 
Handheld Management” in the Novell ZENworks 6.5 Handheld Management Installation Guide.

You can configure how much bandwidth ZENworks Handheld Management should allow when 
the handheld IP client connects to the IP conduit and how often clients should try to connect to the 
IP conduit after failing to connect.

These settings are found in the registry on the IP conduit machine (the sync machine).

The following sections contain additional information:

“Configuring Bandwidth Usage” on page 120

“Configuring Client Retries and Power Down (or Suspend)” on page 120

Configuring Bandwidth Usage
If you have a very limited bandwidth (for example, a wireless network where multiple applications 
use the TCP/IP connection), you can limit how much bandwidth the ZENworks Handheld 
Management handheld IP client should use.

On the IP conduit machine (the sync machine where the Desktop Synchronization Integration is 
installed), the throttle setting is found in the value name Throttle in the following registry entry:

HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ZENworks for Handhelds 
Client\Current Version\Handheld Server

Option Function

/compact Compact and repair a database

/proxy Perform on a proxy service database

/server Perform on a server database
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By default, ZENworks Handheld Management is configured to use 100 percent of available 
bandwidth, which is a setting of 100 (decimal) in the Throttle value. If you set it to 50, ZENworks 
Handheld Management uses just 50 percent of available bandwidth.

If you change this setting, you should test how it works in your environment. Lowering the throttle 
value causes ZENworks Handheld Management messages (that is, applications) to take longer to 
download to the handheld device.

Configuring Client Retries and Power Down (or Suspend)
Windows CE devices power down or suspend by default after a predefined number of minutes of 
inactivity. This counter is reset if there is any activity on the device (for example, a 
synchronization, using the keyboard, and so forth).

Because the IP client periodically attempts to connect to the IP conduit after a failed connection, 
the counter is reset whenever the IP client attempts to connect to the server. To prevent this, the IP 
client uses a default retry connection interval of 60 seconds plus whatever the battery power off 
setting is (by default, 3 minutes).

Without this default, the device might never power down or go into suspend mode.

On the other hand, if your users only connect for short periods of time, the interval might be set 
too high for the client to connect to the IP conduit and therefore your users might not connect to 
the IP conduit frequently enough.

If your users connect for short periods of time and you are concerned that they might not be getting 
their ZENworks Handheld Management messages because the minimum connection interval is set 
too high, you can change the Minimum Connect Retry value in the registry.

This value is found in the registry on the IP conduit machine in:

HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ZENworks for Handhelds 
Client\Current Version\Handheld Server

The setting at the server applies to all handheld devices.

By default, the registry value is 0. This default behavior means that the IP client on the handheld 
device waits 60 seconds plus the battery power auto shutoff setting on the handheld device (by 
default, 3 minutes) to connect to the IP conduit.

The values are in seconds. If you set the value to 25, ZENworks Handheld Management waits 25 
seconds between retry attempts.

Configuring the ZENworks Handheld Management IP Clients
The ZENworks Handheld Management IP clients connect directly to the IP conduit on the 
ZENworks Handheld Management Server or Access Point computer, allowing management of 
Palm OS and Windows CE devices without requiring any third-party synchronization software. 
For more information, see “Installing the Handheld Clients” in “Installing ZENworks Handheld 
Management Server Components” in “Installing ZENworks Handheld Management” in the Novell 
ZENworks 6.5 Handheld Management Installation Guide.

The following sections contain additional information:

“Configuring the ZENworks Handheld Management Palm OS IP Client” on page 121

“Configuring the ZENworks Handheld Management Windows CE IP Client” on page 123
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Configuring the ZENworks Handheld Management Palm OS IP Client
The ZENworks Handheld Management Palm OS IP client has a console (the ZENworks Handheld 
Management console) that allows you to do the following:

Configure the address of the IP conduit and port number to use

Stop and start the proxy service

View the log

Force a connection to the IP conduit

To start the ZENworks Handheld Management Palm OS IP client console:

1 Click the ZENworks Handheld Management console from the Palm OS device’s Application 
Launcher screen.

2 Click Connect Now.

or

Click ZENworks Handheld Management console at the top of the screen to open the drop-
down list, then click an option.
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The following table describes the available options:

Configuring the ZENworks Handheld Management Windows CE IP Client
The ZENworks Handheld Management Windows CE IP client has a console (console.exe) that 
allows you to do the following:

Configure the address of the IP conduit and port number to use

Stop and start the proxy service

View the log

Force a connection to the IP conduit

To start the ZENworks Handheld Management Windows CE IP client console:

1 Click console.exe on the Windows CE device.

Depending on the type of Windows CE device you have, the console looks similar to the 
figure below:

Click To

Configure Configure the handheld server address or port number

View Log View the client log file and enable diagnostic logging

About View the Palm IP client version number and copyright information.
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The following table describes the available options:

Click To

Configure Configure the handheld server address or port number

Log View the client log file and enable diagnostic logging

Connect Now Force a connection to the IP conduit

Stop/Start Client Stop/start the client
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A Troubleshooting

The following sections contain troubleshooting tips and frequently asked questions about Novell® 
ZENworks® 6.5 Handheld Management:

“Error Logs” on page 125

“ConsoleOne Status Pages” on page 125

“Frequently Asked Questions” on page 126

“Contacting Technical Support” on page 129

Error Logs
If you are experiencing a problem, examine the following error logs for insight into errors, 
warnings, or informational messages recorded by ZENworks Handheld Management:

ConsoleOne Status Pages
If you are experiencing problems with policies not being enforced, query-based groups not being 
updated, or handheld applications not being distributed, you can view status pages in Novell 
ConsoleOne® to help you troubleshoot these problems. 

ZENworks Handheld Management lets you view the following types of status information:

Policy Status: You can view policy status information for each enabled policy, including a list of 
all handheld devices that a policy is associated with, the status of each policy, and the date and 
time that the policy was last enforced. You can also view status information about all policies 
associated with a specific handheld device. For more information, see “Viewing Policy Status 
Information” on page 62.

Handheld Group Status: You can view the status of handheld groups, including a list of all 
handheld devices that are members of a specific group, a list of policy packages that are associated 

Log Description

Windows NT/2000/XP Event Viewer Check the Windows* NT*/2000 Event Viewer log for errors, 
warnings, and alerts logged by the ZENworks Handheld 
Management Server service.

Server Error Log (statuslog.txt) Check the log file in the ZENworks Handheld Management 
Server installation directory for errors or informational 
messages logged by ZENworks Handheld Management.

 Client Error Log Check the log file in the ZENworks Handheld Management 
Access Point installation directory for errors or 
informational messages logged by the proxy service.
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with a particular Handheld Group object, and a list of Handheld Application objects that are 
associated to a particular Handheld Group object. For more information, see “Viewing the 
Properties of a Group” on page 75.

Handheld Application Status: You can view a list of all the Handheld Application objects 
distributed by the selected ZENworks Handheld Management Service object, the status of each 
object, and the version number of each Handheld Application object. For more information, see 
“Displaying Handheld Application Object Status” on page 89.

ZENworks Handheld Management Service Object Events: You can view event information 
about policy packages, updates to query-based groups, or Handheld Application objects that the 
ZENworks Handheld Management server has sent (or, in the case of unsuccessful distributions, 
tried to send) to associated handheld devices.

1 In ConsoleOne, right-click the ZENworks Handheld Management service object, then click 
Properties.

2 Click the Events tab.

Frequently Asked Questions
The following sections contain frequently asked questions and provide suggestions and 
troubleshooting tips:

“Why doesn’t my handheld device display in ConsoleOne or in the ZENworks Handheld 
Management Inventory Viewer?” on page 127

“Why are policies that I have configured and enabled not being enforced on individual 
handheld devices?” on page 127

“Why are handheld applications not being installed on individual handheld devices?” on 
page 128
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“Why don’t I see ZENworks Handheld Management inventory information for my registered 
handheld devices?” on page 128

“How does ZENworks Handheld Management manage handheld devices that synchronize at 
multiple computers?” on page 129

“My backup program reports that the ZENworks Handheld Management database files cannot 
be backed up because they are open. Is there a way to shut them down for the backup?” on 
page 129

Why doesn’t my handheld device display in ConsoleOne or in the ZENworks Handheld Management 
Inventory Viewer?

Explanation: Before handheld device objects will display in ConsoleOne, you need to set up the Handheld 
Import policy. For more information, see Chapter 1, “Setting Up Handheld Import,” on page 11.

Explanation: You did not associate the Handheld Import policy correctly. The Handheld Import policy you 
configured and enabled is not in effect until you associate its policy package with a ZENworks 
Handheld Management service object or a container object that contains the ZENworks Handheld 
Management service objects. For more information, see “Associating the Handheld Service 
Package” on page 16.

Explanation: You enabled and associated the Handheld Import policy after the handheld devices connected to 
the ZENworks Handheld Management Access Point. Resynchronize/connect the devices to import 
them into ZENworks Handheld Management.

Explanation: If you are using the sync client, the handheld device needs to synchronize (possibly three times) 
after the ZENworks Handheld Management Desktop Synchronization Integration is installed on 
the computer it synchronizes with.

Why are policies that I have configured and enabled not being enforced on individual handheld 
devices?

Explanation: Policies can be scheduled to run at a certain time. During creation, all policy packages are given a 
default run schedule (EventHandheldSync, by default). This means that all applicable policies in 
this package are enforced every time a handheld device connect/synchronizes.

If you enable a policy but fail to schedule it, it runs according to the schedule currently defined in 
the Default Package Schedule.

You can change the default schedule for an entire policy package or for individual policies. For 
more information, see “Scheduling Packages and Policies” on page 60.
NOTE: Be aware that changing the policy package’s schedule or an individual policy’s schedule to run too 
frequently affects performance, depending on your environment. The default schedule should be adequate for 
most situations.

If you have configured and enabled policies, but they have not been enforced on individual 
handheld devices, consider the following:

1. When you configure and enable policies, ConsoleOne records the new information in the 
directory.

2. The ZENworks Handheld Management Server scans for new information hourly, by default. 
You must wait for up to one hour to ensure that the Handheld Management Server has 
received the policy changes, depending on when the last scan was performed. Or, you can 
force an immediate directory scan to ensure that the Handheld Management Server receives 
the new policy changes by right-clicking the ZENworks Handheld Management Service 
object, clicking Actions, then clicking Scan Now.
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3. For Palm OS* and Windows CE devices, the default Policy Package Schedule is 
EventHandheldSync (whenever the handheld device connects/synchronizes); for 
BlackBerry* devices, the default Policy Package Schedule is once per day. If you have 
changed the default Policy Package Schedule, it might take longer to enforce the policy 
changes on the associated handheld devices. In addition, if the handheld devices were unable 
to connect to the ZENworks Handheld Management system (because of connectivity 
problems, for example), you might need to reconnect/resynchronize the devices.

Explanation: The ZENworks Handheld Management proxy service has not yet connected to the ZENworks 
Handheld Management server. You can force an immediate connection to the ZENworks 
Handheld Management server using the ZENworks Handheld Management Proxy Console on the 
proxy service machine (the Windows machine that the handheld device synchronizes with). 

To force an immediate connection to the ZENworks Handheld Management server: from the 
ZENworks Handheld Management Access Point service installation directory
(program files\novell\zfhap by default), run console.exe, click Operations, then click Connect to 
Server.

Why are handheld applications not being installed on individual handheld devices?

Explanation: The Handheld Application object is not configured properly. For more information, see 
“Configuring a Handheld Application Object” on page 83.

Explanation: The application has already been installed on the handheld device. ZENworks Handheld 
Management does not re-install an application that is already installed on the device. You can force 
an application to be installed, even if it has already been installed on the device, by using the 
Resend button on the Application Status page of the application object. You cannot force 
ZENworks Handheld Management to resend an application by deleting the application from the 
handheld device; you must use the Resend button.

Explanation: The storage device is not available for a Palm OS device. When you configure the Handheld 
Application object, you can specify that the files be installed on a storage card on a Palm OS 
device. If you selected the Install Files on Storage Card option in Step 9 on page 86, ZENworks 
Handheld Management installs the files only to a storage card. If the storage card is not available, 
the installation fails; ZENworks Handheld Management does not install the files in the Palm OS 
device's main memory.

Why don’t I see ZENworks Handheld Management inventory information for my registered handheld 
devices?

Explanation: If you are using the ZENworks Handheld Management sync client, for most synchronization 
packages, inventory is collected by ZENworks Handheld Management every time the device 
synchronizes. The ZENworks Handheld Management client on the handheld device must be run 
manually before synchronizing for ZENworks Handheld Management to get the latest inventory 
information.

If the handheld device is new to the ZENworks Handheld Management system, you might need to 
synchronize the device three times. The first time the device synchronizes with the proxy service 
computer, the handheld client is installed. The second time, the handheld device registers with the 
ZENworks Handheld Management server. The third time, inventory information is sent to the 
proxy service for forwarding to the ZENworks Handheld Management server.
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How does ZENworks Handheld Management manage handheld devices that synchronize at multiple 
computers?

Explanation: ZENworks Handheld Management allows handheld devices to synchronize at multiple computers. 
If you are using the ZENworks Handheld Management sync client and you want to be sure 
software is distributed and inventory collected whenever a device synchronizes, you should install 
the Access Point on every computer where a handheld device synchronizes. For more information, 
see “Installing the Access Point on Additional Computers” in “Installing ZENworks Handheld 
Management Server Components” in “Installing ZENworks Handheld Management” in the Novell 
ZENworks 6.5 Handheld Management Installation Guide.

My backup program reports that the ZENworks Handheld Management database files cannot be 
backed up because they are open. Is there a way to shut them down for the backup?

Explanation: The ZENworks Handheld Management server keeps the ZENworks Handheld Management 
database files open so that they can record any result information they receive. You can shut down 
the ZENworks Handheld Management server and messenger services before the backup and 
restart them after the backup.

If your backup program supports pre- and post-backup commands, you can have the backup 
program perform the work of stopping and starting the services. Otherwise, you will need to handle 
starting and stopping the services and backing up the information yourself.

Before stopping the services, close the ZENworks Handheld Management console and ensure that 
no remote administrators are accessing the installation.

To stop the services from the command line, enter:

net stop “ZENworks Handheld Management Server”

To restart the services from the command line, enter:

net start “ZENworks Handheld Management Server”

Contacting Technical Support
If your troubleshooting efforts do not provide an answer to your questions, Novell Support 
 (http://support.novell.com) provides a range of support options to access top-quality technical 
support.
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B Configuring SSL and HTTP Settings

By default, Novell® ZENworks® Handheld Management uses TCP/IP for communications 
between the Access Point and ZENworks Handheld Management Server and between the 
handheld device and the Access Point.

If you have just one Access Point (installed as part of the ZENworks Handheld Management 
Server), there is no reason to turn on HTTP or SSL because the traffic between the Access Point 
and the ZENworks Handheld Management Server is not going over the network. But you can 
enable HTTP and SSL for communication between handheld devices and the Access Point.

If you configure SSL at the client and the server, additional encryption and verification is done on 
the data and the data source.

If you have installed the Access Point on additional computers outside your firewall or if you have 
handheld devices connecting from outside a firewall, you might want to enable HTTP or SSL so 
that you do not need to open a port in the firewall or if you want all ZENworks Handheld 
Management communications to be encrypted.

If you enable HTTP at the ZENworks Handheld Management Server or Access Point, these 
services will listen to both TCP/IP and HTTP protocols.

SSL is supported on Palm OS devices running Palm OS 5.1 or later, and on Windows CE devices 
running Windows CE 3.0 or later. HPC 2.11 is not supported for SSL communication.

To use SSL communication in PPC 2000 devices, you must install the High Encryption pack for 
Pocket PC 1.0. You must reinstall the pack on every Hard-reset of the device. For more 
information about the High Encryption pack, see Microsoft’s High Encryption Pack for Pocket PC 
Web site (http://www.microsoft.com/downloads/
details.aspx?displaylang=en&FamilyID=DA49D0CF-EF96-4567-B817-215E24668F75).

This section includes the following:

“Configuring the SSL and HTTP Communication between the ZENworks Handheld 
Management Server and the Access Point” on page 132

“Configuring the SSL and HTTP Communication between the Access Point and the Handheld 
Devices” on page 134

“Changing the Default Ports on the ZENworks Handheld Management Server and Access 
Point Communication” on page 137

“Changing the Default Ports for the Access Point and the Handheld Devices Communication” 
on page 138
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Configuring the SSL and HTTP Communication between the 
ZENworks Handheld Management Server and the Access Point

You can configure the SSL and HTTP settings using the cgfip.exe file. 

1 Run the cgfip.exe in the ZENworks Handheld Management installation directory.

2 Obtain a server certificate before using SSL:

2a In the Configure IP dialog box, click Obtain Server Certificate.

2b Review the information in the Certificate Wizard page, then click Next.

2c Specify the common name for the computer in the text box, then click Next.

2d Specify information for your geographic location in the Country/Region, State/
Providence, and City/Locality text boxes, then click Next.

2e Specify information about your organization and organizational unit, then click Next.

2f Specify the location in which you want to save the certificate request, then click Next.

2g Click Finish, then click OK.

2h Have the certificate signed by a Certificate Signing Authority, such as Novell Certificate 
Services (NCS) or VeriSign*. 
NOTE: To use NCS: In ConsoleOne®, click Tools, click Issue Certificate, then follow the prompts. 
When having the certificate signed (if given a choice), have it saved in Base64 format.

Handheld PCs running Windows CE 3.0 and Pocket PC 2000 devices do not support certificates 
originating from NCS.

3 Import a server certificate before using SSL:

3a In the Configure IP dialog box, click Import Server Certificate.
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3b Click Next.

3c Ensure that the Process the Pending Request and Install the Certificate option is enabled, 
then click Next.

3d Browse to the location where you saved the certificate during Step 2h on page 132, then 
click Open. 

3e Click Next.

3f Click Finish.

4 You can publish a trusted SSL root certificate that desktop sync machines or remote Access 
Points automatically download when they connect. This should be the root certificate of the 
Certificate Authority used to sign your server certificate.

If you are using a third-party Certificate Signing Authority and the root certificate does not 
already exist on the PC or handheld device (for example, a root certificate from NCS), you 
can publish the root certificate so that is automatically downloaded. 

To publish a trusted SSL root certificate:

4a In the Configure IP dialog box, click Configure Root Certificate.

4b Browse to and select the signed root certificate, then click Open.

The root certificate that you get from a Certificate Authority (CA) must be in Base64 
format. 

4c Click OK twice.

5 To enable SSL on the ZENworks Handheld Management server, select the Enable SSL check 
box.

6 To enable HTTP on the ZENworks Handheld Management server, select the Enable HTTP 
check box.

7 To enable SSL/HTTP on the Access Point:

7a Run the console.exe file from the zfhap directory.

7b Select Operations > Configure > Server Communications.
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7c To select SSL, select the Use SSL check box. If the server certificate is signed by non-
standard certificate authority, then select the Accept Next Root Certificate check box.

7d To enable HTTP, select the Use HTTP encapsulation check box.

7e Click OK.

Configuring the SSL and HTTP Communication between the 
Access Point and the Handheld Devices

You can configure the SSL and HTTP communication between the Access Point and the Handheld 
devices by using the cfgip.exe from the zfhap directory.

1 Launch cfgip.exe from zfhap directory. 
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2 Obtain a server certificate before using SSL:

2a In the Configure IP - ZENworks Handheld Management Access Point dialog box, click 
Obtain Server Certificate.

2b Review the information on the Certificate Wizard page, then click Next.

2c Specify the common name for the computer in the text box, then click Next.
NOTE: If you want to connect your PPC 2000 device using SSL, you must keep in mind the following 
points:

1. The server address is stored as the IP address because the Domain Name Resolution does not 
work on PPC 2000 devices.

2.  If the PPC 2000 device is connected using IP client through wireless, you must specify the IP 
address of the ZENworks Handheld Management Access Point instead of the common name when 
you create the Certificate Signing Request (CSR) . This enables the device to validate the Certificate 
server. But if the device cradle syncs, you can use the common name by selecting the Use Desktop 
sync settings check box in the ZENworks Console that is available on the device.

2d Specify information for your geographic location in the Country/Region, State/
Providence, and City/Locality text boxes, then click Next.

2e Specify information about your organization and organizational unit, then click Next.

2f Specify the location in which you want to save the certificate request, then click Next.

2g Click Finish, then click OK.

2h Have the certificate signed by a Certificate Signing Authority, such as Novell Certificate 
Services (NCS) or VeriSign. 
NOTE: To use NCS: In ConsoleOne, click Tools, click Issue Certificate, then follow the prompts. 
When having the certificate signed (if given a choice), have it saved in Base64 format.

Handheld PCs running Windows CE 3.0 and Pocket PC 2000 devices do not support certificates 
originating from NCS.
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3 To import a server certificate before using SSL:

3a In the Configure IP - ZENworks Handheld Management Access Point dialog box, click 
Import Server Certificate.

3b Click Next.

3c Ensure that the Process the Pending Request and Install the Certificate option is enabled, 
then click Next.

3d Browse to the location where you saved the certificate during Step 2h on page 135, then 
click Open. 

3e Click Next.

3f Click Finish.

4 You can publish a trusted SSL root certificate that Windows CE clients automatically 
download when they connect. This should be the root certificate of the Certificate Authority 
used to sign your server certificate.

If you are using a third-party Certificate Signing Authority and the root certificate does not 
already exist on the PC or handheld device (for example, a root certificate from NCS), you 
can publish the root certificate so that is automatically downloaded. 

To publish a trusted SSL root certificate:

4a In the Configure IP - ZENworks Handheld Management Access Point dialog box, click 
Configure Root Certificate.

4b Browse to and select the signed root certificate, then click Open.

The root certificate that you get from a Certificate Authority (CA) must be in Base64 
format. 

4c Click OK twice.

5 To enable the SSL on the Access Point, select the Enable SSL check box.

6 To enable HTTP on the Access Point, select the Enable HTTP encapsulation check box.

7 To enable SSL/HTTP on a handheld device, open the ZENworks console and do the 
following:

7a For PalmOS devices, select the server from the drop-down list and select Use SSL

Or

For Windows CE devices, click Configure > Use SSL.

If you are publishing a root certificate, click Accept Next Root Certificate.

7b To enable HTTP for Palm devices, select Server from the drop-down list, then click Use 
HTTP encapsulation

Or

For Windows CE devices, click Configure, then click Use HTTP encapsulation.
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Changing the Default Ports on the ZENworks Handheld 
Management Server and Access Point Communication

1 Run the cfgip.exe from the ZENworks Handheld Management Server installation directory.

2 In the Configure IP - ZEnworks Handheld Management Server dialog box, do the following:

2a Deselect the Use Default check box.

2b Type the desired TCP, SSL, HTTP, and HTTPS ports that you want the ZENworks 
Handheld Management Server to use.

2c Click OK.

3 Configure the Access Point to connect to the new ports.

3a Run the console.exe from the zfhap directory.

3b Select Operations > Configure > Server Communication.

3c Deselect the Use Default Port check box.

3d Specify the desired port that you want the Access Point to use for communicating with 
the ZENworks Handheld Management server.

3e Click OK.
Configuring SSL and HTTP Settings 137



    Novell Confidential                                                                                            Manual (ENU)  21 December 2004
Changing the Default Ports for the Access Point and the Handheld 
Devices Communication

1 Launch cfgip.exe from zfhap directory.

2 In the Configure IP - ZENworks Handheld Management Access Point dialog box, do the 
following:

2a Deselect the Use Default Ports check box 

2b Specify the desired TCP, SSL, HTTP, and HTTPS ports that you want the Access Point 
to use.

2c Click OK.

3 On the Handheld device, open the ZENworks console and do the following:

For PalmOS devices, click the ZENworks menu > Server, then deselect the Use Default Port 
check box. Specify the port that you want the device to use for connecting to the Access Point 

Or

For Windows CE devices, click Configure > Use SSL, then deselect the Use Default Port 
check box. Specify the port that you want the device to use when connecting to the Access 
Point.
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C Documentation Updates

This section contains information on documentation content changes that have been made in the 
Administration guide since the initial release of Novell® ZENworks® 6.5 Handheld Management. 
The information will help you to keep current on updates to the documentation.

All changes that are noted in this section were also made in the documentation. The documentation 
is provided on the Web in two formats: HTML and PDF. The HTML and PDF documentation are 
both kept up-to-date with the documentation changes listed in this section.

The documentation update information is grouped according to the date the changes were 
published. Within a dated section, the changes are alphabetically listed by the names of the main 
table of contents sections for ZENworks 6.5 Handheld Management.

If you need to know whether a copy of the PDF documentation you are using is the most recent, 
the PDF document contains the date it was published on the front title page or in the Legal Notices 
section immediately following the title page.

The documentation was updated on the following dates:

“July 19, 2004” on page 139

“September 7, 2004” on page 140

“February 11, 2005” on page 140

July 19, 2004
Updates were made to the following sections. The changes are explained below. 

Location Change

“Palm Client 
Configuration 
Policy” on page 34

Deleted the following step from the procedure to set up the Palm Client 
Configuration policy because setting up the schedule for this policy is not 
supported in the release:

If desired, schedule the policy. For more information, see “Scheduling 
Packages and Policies” on page 60.

“WinCE Client 
Configuration 
Policy” on page 47

Deleted the following step from the procedure to set up the WinCE Client 
Configuration policy because setting up the schedule for this policy is not 
supported in the release:

If desired, schedule the policy. For more information, see “Scheduling 
Packages and Policies” on page 60.
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September 7, 2004
Updates were made to the following section. The changes are explained below. 

February 11, 2005
Minor formatting changes were made.

Location Change

“Creating Custom 
Reports” on 
page 107

Added the following information:

The ZENworks Handheld Management server database can be either Microsoft 
Access* or MS SQL, depending on the database type you selected during the 
installation of the ZENworks Handheld Management server components. If you 
selected the "Internal ODBC-Compatible Database" option during the 
installation, the Handheld Management server database is the Microsoft Access 
database (serverdata.mdb) located in the Handheld Management server 
installation directory. If you selected the “Microsoft SQL Server” option, the MS 
SQL Handheld Management server database is located in the path specified 
during the installation. For more information, see “Installing the ZENworks 
Handheld Management Server” in “Installing ZENworks Handheld Management” 
in the Novell ZENworks 6.5 Handheld Management Installation Guide.
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